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Photoshop cơ bản: Làm 

quen các công cụ 
 

Cùng làm quen với các công cụ và menu trong Photoshop để hiểu rõ hơn tính 

năng, chức năng cơ bản của các thiết lập và áp dụng vào chỉnh sửa ảnh. 

  

  

Giao diện cơ bản trong Photoshop. 

Bảng Menu 



  

  Vị trí sắp xếp của bảng Menu 

Menu File: Có trong hầu hết phần mềm hiện nay, giúp người dùng làm việc với 

các file cùng các thao tác cơ bản: open, new, save... ngoài ra menu này còn tích 

hợp tính năng hay được dùng khi tạo banner, signature (chữ ký), save for web & 

devices cùng tính năng Browse in Bridge, một chương trình đi kèm 

với Photoshop để duyệt hình ảnh, cho phép người dùng quản lý ảnh dưới dạng 

hình ảnh (không chỉ tên file). 

Menu Edit: Hỗ trợ người dùng với những thao tác cơ bản trong khi làm việc như 

Undo, Step Forward, Step Backward. Trong đó, Undo là một tính năng phổ biến 

và rất thường dùng trong nhiều chương trình hiện nay. Step Forward và Step 

Backward là để di chuyển qua lại giữa các bước trên panel History. Nổi trong 

Menu này là công cụ Fill, có tính năng “đổ đầy” một vùng chọn, layer hoặc 

chanel bằng màu foreground hoặc background, màu trắng, đen hoặc màu trong 

ảnh. Ngoài ra, thao tác Stroke dùng để tạo viền bao quanh vùng chọn. 

Menu Image: cho phép người dùng thao tác với hình ảnh để thay đổi về độ sâu 

của màu, hình ảnh, độ tương phản, độ sáng... Trong đó, thao tác Mode cho phép 

bạn thiết lập ảnh RGB hay CMYK, cũng như các dạng bit màu khác 

như Labhoặc Indexed. Adjustments là một menu phụ với các thành phần điều 

chỉnh độ sáng, độ tương phản, Levels, Curves,cũng như Hue/Saturation (Tham 

khảo bài chỉnh sáng, tương phản từ những thao tác này tại đây). 

 

Menu Layers: Hỗ trợ người dùng chỉnh sửa và làm việc riêng với các lớp layer. 

Trong đó, thao tác New, để tạo ra các lớp mới cũng như các tùy chọn để chuyển 

lớp hiện có thành lớp Background. Thao tác Duplicate Layer, sử dụng để nhân 

bản sao cho layer và New Fill Layer/New Adjustment Layer tạo ra 2 lớp màu 

khác nhau phủ lên trên lớp ảnh hiện tại giúp tạo ra những bức ảnh mang màu 

sắc ấn tượng. 



  

Menu Image 

Menu Select: Liên quan đến vùng chọn, gồm các thao tác Marquee, Lasso, 

Wand, Select All, Deselect và Reselectdùng để chọn đối tượng, bỏ vùng chọn... 

Sử dụng thao tác Invert để đảo ngược phần vùng chọn của ảnh. Ngoài ra, có thể 

điều chỉnh các cạnh của vùng chọn từ menu phụ Modify và tùy chọn chế 

độ Quick Mask. 

 



Menu Filter: Bao gồm rất nhiều các bộ lọc (Filter). Các Filter cho phép bạn lựa 

chọn các hiệu ứng khá thú vị cho bức ảnh, sử dụng các filter tùy thuộc vào mục 

đích của người dùng. Menu này rất hữu ích cho ngường dùng Photoshop và là 

những bộ lọc không thể thiếu cho người chơi ảnh. 

 

Menu View: Cho phép tùy chỉnh cách bố trí giao diện của người dùng. Tích hợp 

các thao tác thay đổi kích thước và hình dạng của điểm ảnh, ngoài ra còn chứa 

các thao tác cơ bản như Zoom in, Zoom out. Trong menu này, bạn cũng có thể 

tắt những điều gây phiền nhiễu như Snap, Rulers cũng như 

xóa Guides hay Slices. 

 

Menu Windows: Giúp người dùng làm việc và quản lý các cửa sổ đang làm việc 

và có thể hiển thị hay tắt các palette trên màn hình. 

 

Menu Help: Chứa mọi thông tin cơ bản của một ứng dụng, qua đó bạn dễ dàng 

kiếm tra, tìm kiểu về các công cụ mà mình chưa nắm rõ hoặc thông số cụ thể về 

phiên bản của phần mềm. 

 

Thanh công cụ 



  

Tính năng cơ bản của các thanh công cụ. 

Những khái niệm thường gặp trong Photoshop 

 

Độ phân giải ảnh: Là số lượng điểm ảnh trên 1 đơn vị (thường là inch). Nếu độ 

phân dải thấp thì số lượng điểm ảnh ít, diện tích của điểm ảnh lớn do đó hình 



ảnh không rõ nét.  

 

Điểm ảnh (pixel): Là những phần tử hình vuông cấu tạo nên file ảnh, hoặc 1 file 

ảnh là tập hợp của nhiều điểm ảnh, số lượng và độ lớn của các điểm ảnh trong 

file ảnh phụ thuộc vào độ phân giải của file ảnh đó. 

 

Vùng chọn: Là giới hạn của hình ảnh được hiển thị bằng đường biên nét đứt, 

cho phép bạn xử lý riêng vùng ảnh đó và chỉ có tác dụng bên trong vùng chọn. 

Vùng chọn được tạo ra bằng các công cụ tạo vùng chọn hoặc một số lệnh tạo 

vùng chọn trong Menu. 



  

Khi đã tạo vùng chọn chỉ có thể xử lý hình ảnh trong vùng chọn này. 

Layer: Mỗi hình ảnh tách rời trong khuôn hình đang chỉnh sửa là lớp ảnh 

(layer). Trong 1 layer thường có những vùng chứa điểm ảnh hoặc không chứa 

điểm ảnh, gọi là vùng trong suốt. 

 

Màu nền tiền cảnh/Màu nền hậu cảnh: Đây là 2 bảng màu cơ bản, hiển thị màu 



nền sử dụng trong Photoshop. Trong đó, màu nền tiền cảnh dùng để tô, vẽ vào 

ảnh, thường sử dụng với công cụ Brush Tool và Paint Bucket Tool…, còn màu 

nền hậu cảnh là màu nền bên dưới hình ảnh, màu giấy. Màu mặc định của 2 

bảng này là đen/trắng (trong Photoshop thường sử dụng phím tắt “d” để trở về 

màu mặc định).  

  

 



Công cụ chỉnh sửa ảnh cho người không thạo 

Photoshop 

Bạn cần có 1 phần mềm đa năng giúp bạn quản lý, 

xem và chỉnh sửa hình ảnh tất cả trong một, thì 

Zoner Photo Studio là cái tên bạn không thể bỏ 

qua.  

Hình ảnh là 1 trong những loại tập tin phổ biến đối 

với mọi người dùng máy tính. Và dĩ nhiên cũng có rất 

nhiều phần mềm giúp bạn quản lí và chỉnh sửa loại 

tập tin này như Windows Photo Viewer, Paint, 

Photoshop…  

  



 

  

Tuy nhiên, bạn cần có 1 phần mềm đa năng giúp bạn 

quản lý, xem và chỉnh sửa hình ảnh tất cả trong một, 

thì Zoner Photo Studio là cái tên bạn không thể bỏ 

qua. Có thể nói Zoner Photo Studio là 1 phần mềm 

đa năng, ngoài quản lý, xem và chỉnh sửa hình ảnh, 

bạn còn có thể chia sẽ hình ảnh lên các mạng xã hội 

nổi tiếng. 

  

Bạn có tải Zoner Photo Studio miễn phí tại địa chỉ 

sau đây. 



  

Sau khi cài đặt xong, cửa sổ “First Run Wizard” yêu 

cầu bạn nhập thông tin cấu hình cho ứng dụng. 

  

 

  

Tiếp theo là liên kết tới 1 số tài liệu hướng dẫn sử 

dụng đơn giản, tùy theo nhu cầu bạn có thể tải 1 số 

tài liệu dạng pdf về tham khảo. 



  

 

  

Giới thiệu tổng quan 

  

Ở lần khởi động đầu tiên, bạn sẽ tiếp cận với tính 

năng quản lý hình ảnh của Zoner Photo. Bạn có thể 

xem qua các tính năng cơ bản mà phần mềm hỗ trợ ở 

thanh công cụ góc trên bên phải của cửa sổ. 

  



 

  

Chức năng quản lý hình ảnh giúp bạn duyệt các hình 

ảnh trong ổ cứng như Windows Explorer nhưng ở 

đây chỉ hiện thị các tập tin hình ảnh với các công cụ 

như xoay ảnh, cắt và đóng khung ảnh. 

  

 

  



Khi bạn bấm vào 1 hình ảnh bất kì, chương trình sẽ 

đưa bạn qua cửa sổ xem và chỉnh sửa bức ảnh đó. 

  

 

  

Bạn có thể thay đổi qua lại giữa cửa sổ quản lý và 

chỉnh sửa ảnh bằng thanh lựa chọn ở góc trên của 

phần mềm. 

  



 

  

Cửa sổ chỉnh sửa hình ảnh cung cấp cho bạn đầy đủ 

các công cụ cần thiết như sau: 

  

 



  

Cũng như những phần mềm khác, bạn chọn Setting 

để thay đổi các cài đặt cho phù hợp với nhu cầu. 

  

 

  

Để có không gian làm việc rộng hơn, chương trình 

cũng cho phép bạn ẩn bớt các thanh công cụ và menu 

ít dùng tới. 

  



 

Hướng dẫn sử dụng 1 vài chức năng phổ biến 

  

Với 1 Studio đa năng như vậy, người dùng lần đầu 

tiên sẽ khó có thể sử dụng thành thạo tất cả. Do đó, 

genk sẽ trình bày cụ thể 1 số chức năng mà chắc chắn 

nhiều người sẽ cần và dùng đến thường xuyên. 

Ở cửa sổ quản lý, bạn chọn menu “Public” sẽ thấy rất 

nhiều công cụ để bạn xuất bản tập ảnh của mình như : 

làm slide trình chiếu, làm hình nền cho desktop và 

làm lịch. Dưới cùng còn có thêm 1 công cụ để đưa 

hình ảnh của bạn lên mạng xã hội Facebook và 

Flickr. 

  



 

  

Để thêm hiệu ứng vào ảnh, trong cửa sổ biên tập hình 

ảnh, bạn chọn menu “Effects” và thử các hiệu ứng mà 

Zoner Photo cung cấp cho bạn. Các hiệu ứng ở đây 

gần giống như hiệu ứng của công cụ Filter trong phần 

mềm Photoshop. 

  

 



  

Ví dụ như với hiệu ứng “Pencel Drawing” để chuyển 

hình ảnh bạn chọn thành hình ảnh vẽ bằng bút chì. 

Bạn chỉ cần chọn các giá trị trong hộp thoại hiện ra 

và thưởng thức kết quả. 

  

 

  

Tóm lại, Zoner Photo Studio thực sự là 1 lựa chọn 

tốt cho nhu cầu quản lý và chỉnh sửa hình ảnh cơ 

bản. Bạn có thể tự tìm hiểu qua các hướng dẫn kèm 

theo để khám phá hết tính năng có thể khai thác 

được. 
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Sử dụng công cụ Curves trong Photoshop  

Saturday, 01 May 2010 13:08 13 Comments  

Tác dụng không thể thiếu của Adobe Photoshop đối với ảnh số có lẽ 

không cần phải nói nhiều. Với những công cụ chuyên nghiệp hiệu chỉnh 

chi tiết về ánh sáng, màu sắc, thậm chí là thay đổi hình dạng, phù phép 

cho ảnh số; thực sự Photoshop là hành trang không thể thiếu trong nhiếp 

ảnh cũng như thiết kế, in ấn. Nhưng nếu bắt buộc phải từ bỏ hết các công 

cụ hiệu chỉnh trong Photoshop chỉ giữ lại duy nhất 1 công cụ, phải chọn 

công cụ nào đây? 

Đó chính là Curves. 

Dài dòng một chút, thực ra bài này chính là để nói về Curves mà :)). Mình thích Curves, 

hầu như mình luôn sử dụng Curves khi phải dùng đến Photoshop. Nó chứa đựng sức 

mạnh có thể thoả mãn gần như toàn diện các mục đích hiệu chỉnh một tấm ảnh từ xấu lên 

đẹp. Tuy nhiên đây lại không phải là một công cụ dễ nắm bắt và sử dụng nhuần nhuyễn, 

ít nhất là khi mới tiếp xúc, hoặc với người bắt đầu làm quen với Photoshop. Bài viết này 

rút ra từ kinh nghiệm nghiên cứu và thực hành của mình, ghi chép lại cố gắng theo cách 

chuyên nghiệp một chút để hệ thống hoá quá trình học Photoshop của bản thân, đồng thời 

hy vọng cũng giúp ích cho những người chưa biết. 

Curves có những tác dụng gì? 

Rất nhiều, và là những tác dụng cơ bản cần thiết khi hiệu chỉnh một tấm ảnh: 

 Chỉnh độ sáng, độ tương phản trên toàn bộ tấm ảnh, hoặc trên một phạm vi (miền) 

sắc độ 

 Chỉnh độ sáng, độ tương phản trên từng khu vực riêng của tấm ảnh, hoặc trên một 

phạm vi (miền) sắc độ của khu vực đó 

 Chỉnh màu cho tấm ảnh 

Các khái niệm cơ bản 

Trước khi tìm hiểu sâu hơn về Curves, có lẽ cần phải đi qua một số khái niệm đơn giản 

về màu RGB - hệ màu mặc định mà chức năng Curves sử dụng. 
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Những tác dụng mà Curves tạo nên có thể gây ảnh hưởng riêng biệt đến 4 kênh màu: 

RGB, R, G và B. Trong đó mặc định là kênh RGB (trắng), và có thể chuyển đổi qua các 

kênh riêng khác: R (đỏ), G (xanh lá) và B (xanh dương). Điều này là dễ hiểu bởi 3 màu 

cơ bản đỏ, xanh lá và xanh dương khi hoà trộn vào nhau sẽ cho màu trắng. Như vậy có 

nghĩa là nếu chỉnh Curves ở kênh RGB thì sẽ có tác dụng thay đổi sáng/tối trên cả 3 màu 

cơ bản của tấm hình (nhưng vì hoà trộn vào sẽ được màu trắng nên mắt người chỉ nhận 

thấy tấm ảnh sáng đều hoặc tối đều từ đen tới trắng mà thôi). Nếu chỉnh Curves trên một 

kênh màu riêng thì sẽ chỉ có tác dụng sáng/tối trên phạm vi kênh màu đó. Ví dụ, chỉnh 

Curves trên kênh Red thì chỉ có những phần (cụ thể là những pixel) có sắc độ liên quan 

tới màu đỏ mới thay đổi độ sáng, tối - các sắc độ khác giữ nguyên. 

 

RGB basic colors 

Dựa vào biểu đồ pha trộn màu trên đây, có thể hiểu rõ hơn điều vừa viết. Ngoài ra nhờ 

biểu đồ này ta có thể nhận biết rõ vị trí của màu Cyan (trộn giữa xanh dương và xanh lá), 

Magenta (trộn giữa đỏ và xanh dương), Yellow (trộn giữa đỏ và xanh lá). Ba màu này 

(chính là Xanh Ngọc, Tím và Vàng) được ứng dụng rất nhiều trong các công cụ chỉnh 

màu của Photoshop. 



Phạm vi sắc độ (Tonal Range) là gì? 

Phạm vi sắc độ của một tấm ảnh (Tonal Range) có thể hiểu đơn giản là một dải giá trị thể 

hiện mức độ sáng/tối, chạy từ điểm màu có giá trị tối nhất tới điểm màu có giá trị sáng 

nhất của tấm ảnh đó. 

Khái niệm Tonal Range là điều cần thiết nên biết để sử dụng tốt Curves. Thông thường 

điểm màu có giá trị tối nhất của mỗi tấm ảnh chưa chắc đã là màu đen, và điểm màu có 

giá trị sáng nhất chưa chắc là màu trắng; tuy nhiên một tấm ảnh tốt thì điểm tối nhất 

thường là màu đen và điểm sáng nhất là màu trắng. Khi độ tương phản đủ cao thì tấm 

hình trở nên rõ ràng dễ nhìn hơn. Đó là lý do phải dùng đến Curves. 

Ví dụ: 

Di chuột lên hình để xem biểu đồ về phạm vi sắc độ 

Hình 1 (Phạm vi sắc độ hẹp) 

Hình 2 (Phạm vi sắc độ rộng) 

Trong hai hình trên, hình bên trái có dải phạm vi sắc độ hẹp, điểm tối nhất cũng chẳng tối 

lắm mà điểm sáng nhất cũng không sáng hẳn, vậy nên độ tương phản tổng thể thấp, hình 

rất khó nhìn. Hình bên phải có phạm vi sắc độ trải từ tối nhất (đen) tới sáng nhất (trắng), 

hình ảnh cải thiện hơn. 

Tổng quan về hộp công cụ Curves 

Như đã biết có 2 cách chỉnh Curves, đó là: 

 Images → Adjustments → Curves... (hoặc Ctrl + M)  

 Layer → New adjustment layer → Curves... (hoặc creat adjustment layer ở 

Layer Palette) 

Tuy nhiên trong đa số trường hợp ta nên chọn cách 

thứ 2 (adjustment layer) vì có thể chỉnh sửa hay xoá 

tiện lợi hơn mà không ảnh hưởng đến layer gốc, nên 

trong bài viết này cũng chỉ đề cập đến Curves ở 

trong Adjustment layer box. 

 

Curve có nghĩa là đường cong, về mặt cơ bản, công 

cụ Curves cho phép ta chỉnh sửa độ sáng của màu 

sắc thông qua việc điều chỉnh một đường đồ thị. 

Đường này là tập hợp các giá trị sắc độ của hình ảnh 

từ tối nhất (đen) tới sáng nhất (trắng). Khi chưa 



chỉnh sửa gì, đường đồ thị đó là một đường thẳng, sau khi chỉnh sửa nó sẽ thành một 

(hoặc nhiều) đường cong. 

Hình bên mô tả đường Curves mặc định, khi chỉnh sửa nên ngầm phân chia giá trị các sắc 

độ thành những khoảng khác nhau: Sáng nhất (White point), Sáng (Highlights), Trung 

tính (Midtones), Tối (Shadows) và Tối nhất (Black point); sau đó đánh giá tấm hình để tự 

đưa ra quyết định nên tăng hay giảm giá trị sắc độ ở khoảng nào. 

Click chuột lên một điểm bất kỳ trên đường Curves, sẽ xuất hiện một dấu chấm tại điểm 

đó. Ta có thể giữ chuột và thay đổi vị trí điểm đánh dấu đó để thay đổi sắc độ. Cũng như 

mọi đồ thị khác, đồ thị Curves cũng có cột giá trị X và Y, ở đây là Input và Output. 

Input được hiểu là dải giá trị sắc độ của hình ảnh trước khi chỉnh sửa, Output là dải giá trị 

sắc độ của hình ảnh sau khi chỉnh sửa. Khi chưa chỉnh sửa, đường Curves đi thẳng từ tối 

nhất lên sáng nhất, tại mọi điểm trên đường Curves, ta có Input=Ouput (X=Y) 

Cơ chế hoạt động của Curves: 

Di chuyển điểm đánh dấu trên đường Curves. 

Sau khi di chuyển, những điểm màu mang giá 

trị sắc độ tương ứng trên dải Input sẽ biến đổi 

(sáng hơn hoặc tối hơn) thành giá trị tương 

ứng trên dải Ouput. 

Hình bên phải minh hoạ cho cơ chế của 

Curves. Cùng một mục đích với công cụ 

Level, nhưng Curves mềm dẻo hơn rất nhiều, 

có thể tạo tối đa 14 điểm chỉnh sửa trên 

đường Curves (ngoài 2 điểm đầu và cuối). 

 

 

Các nút và chức năng trong Curves box 



 

S-Curves và Inverted S-Curves 

Chỉnh Curves theo hình chữ S và theo hình chữ S ngược là 2 kiểu thông dụng nhất. Bởi 

thông thường trong đa số trường hợp, chỉ có 2 mục đích chính là tăng hoặc giảm độ sáng 

(hay tương phản) của tấm ảnh một cách đồng đều. Trừ khi người thiết kế muốn chỉnh ảnh 

theo một mục đích quái dị. 



Chỉnh Curves theo hình chữ S làm giảm độ tương phản ở các khoảng Shadows và 

Highlights, đồng thời tăng độ tương phản ở Midtones, nên làm tăng độ tương phản tổng 

thể của tấm ảnh. Trong khi chỉnh Curves theo hình chữ S ngược lại cho kết quả ngược 

lại. 

Di chuột lên hình để xem sự thay đổi sau khi chỉnh Curves hình chữ S 

 

Chỉnh Curves theo hình chữ S 

 

Biểu đồ (Histograms) và phạm vi sắc độ rỗng (Empty 

Tonal Range) 

Như chú thích trong hình minh hoạ Curves box, nằm chìm phía trong đồ thị Curves là 

biểu đồ (Curves Histograms). Biểu đồ này thể hiện số lượng điểm ảnh (pixel) tại các 

khoảng sắc độ khác nhau. Bình thường khi chỉnh sửa ảnh có thể không mấy ai để ý tới 

biểu đồ này, tuy nhiên đối với những tấm hình có độ tương phản quá thấp, biểu đồ cung 

cấp cho chúng ta thông tin tuyệt vời để chỉnh sửa lại cho vừa đúng mà không sợ quá tay. 

Trong hình dưới đây, pixel tối nhất của tấm ảnh cũng chỉ màu xám một chút, và pixel 

sáng nhất của ảnh cũng không sáng hoàn toàn. Như đã biết ở các mục trên, tấm hình này 

được gọi là có phạm vi sắc độ hẹp. Tuy nhiên mức độ hẹp bao nhiêu thì phải xem biểu đồ 

mới chỉnh đúng được. Ở các tấm hình có Tonal Range hẹp như thế này, phía trước và 

phía sau đồ thị (trước điểm ảnh đầu tiên và sau điểm ảnh cuối cùng) thường có một 

khoảng trắng, vì không có điểm ảnh nào đạt sắc độ trong các khoảng đó cả. Khoảng trắng 

đó gọi là Phạm vi sắc độ rỗng (Empty Tonal Range). 

Để cứu vãn tình thế, chỉ cần kéo điểm hiệu chỉnh trên đường Curves tại vị trí Black point 

(tối nhất) tới điểm bắt đầu của biểu đồ (Histograms), đồng thời kéo điểm White point 

(sáng nhất) lùi lại điểm cuối cùng của biểu đồ. Làm như vậy ta đã xoá bỏ các phạm vi sắc 

độ rỗng, và xác định lại điểm sáng nhất, tối nhất ở sắc độ hợp lý hơn. 

Di chuột lên hình để xem sự thay đổi sau khi loại bỏ Empty Tonal Range 

Khắc phục Empty Tonal Range 

Ngoài ra còn có một trường hợp hiếm gặp của Empty Tonal Range đó là khoảng trắng 

xuất hiện ở giữa biểu đồ, chia biểu đồ thành 2 khoảng về phía Shadows và Highlights, 

còn Midtones thì ít hoặc không có gì. Trường hợp này thực sự hiếm gặp và thường thấy ở 

những bức ảnh bị chỉnh sửa hỏng, tăng độ tương phản quá mức, các pixel quá tối hoặc 

quá sáng thì nhiều còn các pixel màu trung tính thì ít hoặc không có. Ở ảnh chụp gốc thì 

ít gặp trường hợp này vì hầu hết đều chỉ thiếu chứ không thừa tương phản bao giờ (trừ 

trường hợp dùng flash hỏng hoặc đặt chế độ White Balance không đúng). Khi gặp phải 



Empty Tonal Range ở giữa đồ thị, cách khắc phục là chỉnh thành hình chữ S ngược ở 

khoảng Midtones (cụ thể là khoảng bị Empty Tonal) để giảm Contrast nhằm cứu vãn tình 

thế. Tuy nhiên nếu ảnh chụp là file RAW thì mới có khả năng cứu, còn bằng file JPEG 

thì hầu hết là mất chi tiết ở những điểm sáng quá hoặc tối quá, khó mà cứu nổi. 

Trường hợp này ít gặp hơn nên mình cũng chịu không có hình mình hoạ ^^! 

Giảm bớt độ sáng gắt (Clipped Highlights) 

Trong một số trường hợp chụp nguồn sáng mạnh (như mặt trời hoặc đèn cao áp) mà 

không có filter UV hoặc filter Polarizer, ảnh rất có thể sẽ bị sáng loá hoặc gắt, gây khó 

chịu cho người xem. Không những thế ảnh chụp ra còn trông không thật, nhìn cứ như 

tranh màu nước. Curves có thể điều chỉnh tốt việc này để vùng sáng gắt trên ảnh chuyển 

tiếp mượt mà hơn với các vùng xung quanh. 

Thông thường có thể khắc phục trường hợp này bằng cách giảm độ dốc của đường 

Curves ở khoảng Highlight (sáng nhất), và tinh chỉnh thêm nếu không muốn các vùng 

khác thay đổi theo nếu cần. 

Di chuột, di chuột! 

Chỉnh Curves để giảm bớt độ sáng gắt 

Điều chỉnh cân bằng màu (Color Balance) 

Curves không chỉ dùng để chỉnh sáng tối, nó thực sự còn thay đổi được tông màu, điều 

chỉnh lại cân bằng giữa các kênh màu cho chuẩn hoặc pha màu tấm ảnh theo mục đích 

riêng. Sau khi chỉnh Curves chữ S, hoặc khắc phục Phạm vi sắc độ rỗng, màu ảnh luôn 

tươi tắn hơn, nhưng đó chưa phải là tất cả đối với Curves. Photoshop có hẳn một chức 

năng Color Balance riêng, nhưng ngay trong công cụ Curves ta có thể làm điều đó mà kết 

quả không kém khác một chút nào. 

Như đã biết Curves có ảnh hưởng mặc định trên kênh màu RGB, nhưng có thể áp dụng 

riêng trên từng kênh màu R, G và B để tăng giảm sắc độ của từng kênh màu mà không 

ảnh hưởng đến kênh màu khác. Nguyên tắc chuyển màu trên từng kênh như sau: 

 Kênh Red: tăng sáng được màu Đỏ, giảm sáng được màu Xanh ngọc (Cyan) 

 Kênh Green: tăng sáng được màu Xanh lá, giảm sáng được màu Tím (Magenta) 

 Kênh Blue: tăng sáng được màu Xanh dương, giảm sáng được màu vàng 



 

Về bản chất, màu RGB gồm có 1 kênh màu pha trộn và 3 kênh đen trắng mang giá trị sắc 

độ của 3 màu Red, Green, Blue. Hình dưới đây minh hoạ lần lượt 4 kênh màu đó trong 1 

tấm ảnh. Trong Photoshop, có thể bật Menu Windows → Channels... để so sánh rõ hơn 

sắc độ của từng kênh màu. 

 

Trong nhiều trường hợp khi chụp ảnh ta gặp phải tình trạng bị ánh sáng phản chiếu vào 

ống kính gây lệch sắc thái ở một màu nào đó (hiện tượng ám màu). Khi đó vẫn chỉ với 

Curves, ta có thể điều chỉnh lại. Trong hình dưới đây, qua nhận định ban đầu có thể thấy 

ảnh bị ám màu xanh (Blue) một chút ở những vùng tối. Mở Channel Blue trong Curves 

ra, ta thấy ngay có một chút Empty Tonal Range ở khoảng Shadows, như vậy những 

vùng tối của ảnh không đen như bình thường mà lại xanh nhiều hơn. Áp dụng các cách 

tinh chỉnh đường Curves, có thể điều chỉnh lại ngay sau vài giây, kết quả cho nước ảnh 

nhìn có cảm giác trong hơn. 

Di chuột nữa 

Khắc phục ảnh bị ám màu bằng Curves 

Trong hình trên, ta thấy các phần Highlights của tấm ảnh đã đủ độ sáng, do vậy nên để 

nguyên không cần tăng thêm, chỉ giảm một chút ở vùng Shadows để viền thuỷ tinh ở 

phần chân chiếc cốc nét hơn một chút.  

Chế độ hoà trộn cho Curves (Blending Modes) 



Khi sử dụng Adjustment layer cho Curves, ta còn có 

thể quy định ảnh hưởng của Curves chỉ có tác dụng 

trên màu của ảnh (Color) hoặc chỉ trên Độ sáng tối 

của ảnh (Luminosity). Dùng các Blending Modes 

(chế độ hoà trộn) cho Adjustment layer để thực hiện 

điều đó, cụ thể là blend mode Color và blend mode 

Luminosity. Khi chọn blend mode là Color thì 

Curves chỉ có tác dụng trên các kênh màu R, G, B 

(tức là độ sáng tối cho các kênh màu); còn khi chọn 

Luminosity thì Curves chỉ có tác dụng trên kênh 

chung RGB (sáng đều và tối đều nhau). 

Có thể hiệu chỉnh cùng Blend Mode tinh tế hơn nhờ thay đổi Opacity của Adjustment 

layer. 

 

Trên đây là những điều cần biết về công cụ Curves trong Photoshop. Trong lúc viết bài 

này, mình cũng thực hành không ít vì phải làm ảnh minh hoạ ^^, áp dụng thực tế một 

chút sẽ thấy dễ hiểu hơn nhiều. Ứng dụng của Curves có lẽ còn xa hơn những điều viết 

bên trên, tuỳ thuộc vào cảm quan đánh giá và sự linh hoạt của người sử dụng. Tuy nhiên 

muốn làm gì cho tốt thì trước tiên nên hiểu rõ về nó. Công cụ Curves mới đầu khó hiểu là 

vậy nhưng thực ra cũng chỉ xoay quanh nguyên lý sáng tối với những màu cơ bản, vận 

dụng tốt Curves chắc chắn sẽ mang lại kết quả cao và tiết kiệm thời gian trong xử lý hậu 

kỳ ảnh số. 

Cuối cùng, một số chú ý nhỏ: 

 Hãy thực hành Curves với ảnh mới chụp, đừng làm trên ảnh đã xử lý rồi 

 Để hiệu quả thể hiện rõ rệt hơn, hãy chuyển sang chế độ màu 16 bit (Image → 

Mode → 16 Bits/Channel) 

 Curves mà dùng kết hợp với chế độ Lab Color thì còn nhiều hiệu quả bất ngờ 

khác nữa ;)  

Tags: 

 Curves 

 Photoshop 

 studying 

 

http://misoblog.net/tag/curves.html
http://misoblog.net/tag/photoshop.html
http://misoblog.net/tag/studying.html


Chức năng của công cụ Colour replacement tool 

và công cụ quick selection tool 

 

Đầu tiên là Colour replacement tool 

Lệnh Replace Color cho phép bạn tạo một mặt nạ tạm thời lên vùng chọn của 

ảnh để chọn ra những vùng màu mà bạn muốn thay đổi. Bạn có thể thiết lập thông số 

màu sắc, độ sắc nét và độ sáng tối cho vùng chọn đó 

Với bài tập ví dụ như sau: 

Bước 1: tạo vùng chọn  

- Tạo vùng chọn cho đối tượng cần xử lý màu sắc bằng công cụ Magic Tool, 

Polygonal Lasso Tool, nếu đối tượng có hình dáng phức tạp, bạn có thể dùng Pen Tool 

để tạo vùng chọn.  

- Vào Select\Feather chọn Reather Radius = 20 pixels để vùng chọn được mềm 

mại, đường biên của vùng chọn không quá sắc nét, khi đổi màu sẽ được trộn vào trong 

nền cũ.  

 

Bước 2: đổi màu  

- Vào Image\Adjustment\Replace Color, xuất hiện hộp thoại  



 

- Dùng công cụ hút màu (Eye Dropper) để chọn vùng cần đổi màu, thử click 

vào một chỗ khác, vùng màu "bắt" được sẽ thay đổi vì nó dựa trên tông màu của các 

điểm ảnh nằm gần nhau nhất. Nếu muốn chọn thêm "khu vực" khác, bạn dùng công cụ 

hút màu kèm theo dấu cộng.  

- Ô Color hiển thị màu sắc của đối tượng gốc.  

- Fuzziness: thông số này giúp bạn mở rộng hay thu nhỏ vùng chọn  

- Dấu check "Selection" và "Image" cho bạn chuyển đổi qua lại giữa vùng chọn 

và ảnh gốc để xem lại dễ dàng hơn. Tuy nhiên, mỗi thao tác thực hiện, ảnh trong vùng 



làm việc chính cũng thay đổi theo, cho bạn xem kết quả ngay tức thì. Vùng được che 

mặt nạ là màu đen, vùng không che mặt nạ là màu trắng. Màu thay đổi sẽ được áp 

dụng lên vùng màu trắng.  

- Vùng Replacement là vùng quyết định màu sắc của đối tượng.  

+ Thanh trượt Hue giúp bạn chọn màu sắc mới cho đối tượng  

+ Saturation: sắc độ của ảnh.  

+ Lightness: dùng để chỉnh độ sáng tối.  

- Khi chọn vùng chọn, chỉ chọn phần ruột màu vàng, trừ phần màu trắng như 

hột, vỏ...  

- Sau khi chọn xong vùng chọn, bạn quyết định thông số như trong ảnh để thay 

đổi phần ruột của quả cam từ màu vàng biến thành màu đỏ hay bất cứ màu nào bạn 

thích bằng cách dùng thanh trượt Hue. Tuy nhiên, không phải màu sắc nào cũng cho ra 

kết quả vừa ý, thường xảy ra hiện tượng "cháy" màu do độ tương phản quá cao.  

 

- Áp dụng thao tác vừa rồi cho nửa quả cam còn lại:  



 

So sánh hiệu quả giữa công cụ Hue&Saturation và Replace Color  

Cả 2 công cụ đều được dùng cho việc thay đổi màu sắc của ảnh hay một đối 

tượng nằm trong ảnh. Tuy nhiên, Hue&Satuation thay đổi màu sắc toàn bộ đối tượng, 

khiến màu sắc mới được áp lên đối tượng không tự nhiên.  



 

Hãy xem kết quả được áp dụng bằng Replace Color:  



 

- Hãy xem xét vùng chọn, các điểm ảnh màu trắng sẽ được thay thế bằng các 

điểm ảnh màu cam mà bạn đã chọn ở tùy chọn Hue. Vùng chọn được hình thành trong 

Replace Color khác với vùng chọn trong Hue&Saturation, do đó kết quả cũng khác 

nhau.  

- Hãy thử biến đổi quả chín thành quả còn xanh, chỉ việc chọn vùng chọn cho 

cả quả cam, lưu ý đừng chọn hết các điểm ảnh nằm trên quả cảm. Xem xét vùng chọn 

trong bảng Replace Color, bạn sẽ thấy vẫn còn một số vùng ảnh màu đen, nó sẽ giữ lại 

màu nguyên gốc của ảnh. Khi áp dụng màu mới, nó sẽ hòa trộn với màu cũ tạo nên độ 

trung thực cho ảnh của bạn.  



 

quick selection tool: là công cụ dùng để tạo nhanh vùng chọn, cách thức hoạt 

động của công cụ này là sẽ tự tìm nhửng vùng màu tương đồng với nhau để tạo vùng 

chọn, công cụ này thích hơp khi mẩu chụp ở 1 phông màu nhất định, khi đó bạn sẽ dể 

tạo vùng chọn và tách lớp hơn. 

History Brush Tool:Công cụ này dùng để Undo một phần của bức ảnh chứ 

không phải toàn bức ảnh như history states. Bạn phải chọn nguồn để History Brush 

tool undo đến trạng thái bức hình tương ứng. Click vào ô trống ở trước mỗi Snapshop ( 

điểm A trên hình) để chọn đó làm nguồn. Dùng nó vẽ lên vùng muốn Undo giống như 

Brush vậy. 

Art History Brush: Mô phỏng các kiểu tô khác nhau bằng các nét vẽ nghệ 

thuật. 
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Nội dung của trang này thuộc bản quyền của © Bá tước Monte Cristo - Final Fantasy và www.vietphotoshop.com. Những bài viết 

trong này có thể được in ra để dùng với mục đích cá nhân và phi thương mại. Nếu bạn muốn phát hành lại trong trang web của bạn làm 

ơn liên lạc với tôi hoặc ít nhất phải trích dẫn lại nguồn là: Bá tước Monte Cristo - Final Fantasy và www.vietphotoshop.com 

 

Công cụ Pen dùng để vẽ những đường thẳng hoặc những đường cong gọi là Path. Bạn có thể sử dụng 

côgn cụ Pen như là một công cụ tô vẽ hoặc nhu một công cụ lựa chọn. Khi được sử dụng như là công 

cụ lựa chọn, công cụ Pen luôn luôn tạo được một đường mềm mại, Anti-alias. Những đường tạo ra bởi 

Pen là một sự lựa chọn tuyệt vời để sử dụng những công cụ lựa chọn chuẩn cho việc tạo ra những 

vùng lựa chọn phức tạp. 

Trong bài này bạn sẽ học được những điều sau: 

• Thực hành vẽ một đường thẳng và cong sử dụng công cụ Pen 

• Lưu lại Path 

• Tô với lệnh Stroke Path 

• Chỉnh sửa Path bằng công cụ Path Editing 

• Biến đổi Path thành vùng lựa chọn 

• Biến đổi vùng lựa chọn thành Path 

Bắt đầu: 

Bạn sẽ bắt đầu bài học bằng việc xem một bản sao của một bức hình hoàn thiện mà bạn sẽ tạo. Sau 

đó bạn sẽ mở một loạt các file có những hướng dẫn giúp bạn đi qua quá trình tạo một đường thẳng, 

đường cong và đường kết hợp của hai đường trên. Hơn nữa, bạn sẽ học cách thêm một điểm vào 

Path, bớt điểm đi ở Path và biến một đường thẳng thành đường cong và ngược lại. Sau khi bạn thực 

hành xong với việc vẽ và chỉnh sửa Path sử dụng các Template, bạn sẽ mở một tấp hình đồ chơi con 

tàu vũ trụ và thực tập thêm với việc tạo vùng lựa chọn bằng công cụ Pen.  
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1. Trên thành tuỳ biến công cụ, chọn nút File Browser.  

2. Trong FIle Browser Palette, tìm đến thư mực Lesson9 và chọn file 09End.psd trong cửa sổ biểu 

tượng thu nhỏ để hình đó xuất hiện bên cửa sổ xem trước. File 09End.psd là kết quả cuối cùng của 

hình chiếc đĩa bay. Nếu bạn đã có kinh nghiệm về vẽ vector bạn có thể lướt qua đoạn đầu của bài học 

này để biết về công cụ và tuỳ biến của nó trong Photoshop khi bạn bắt đầu làm việc với bài tập về đĩa 

bay này.  

3. Nhấp đúp vào hình biểu tượng thu nhỏ của file Straight.psd để mở nó ra trong Photoshop. 

4. Nếu cần, chọn công cụ Zoom nhấp hoặc kéo qua tấm hình để phóng lớn nó 

Đôi điều về Path và công cụ Pen 

Công cụ Pen vẽ một đường thẳng và cong được gọi là Path. Path là dạng đường nét hoặc hình dạng 

mà bạn vẽ ra nó bằng công cụ Pen, Magnetic Pen hoặc FreeForm Pen. Trong những công cụ này, 

công cụ Pen vẽ đường thẳng chính xác nhất, công cụ Magnetic Pen và Freeform dùng để vẽ những 

đường gần giống như bạn vẽ nháp bằng cây bút chì trên giấy vậy. 

Nhấn chữ P trên bàn phím để chọn công cụ Pen. Nhấn Shift+p để thay đổi lần lượt giữa công cụ 

Pen, Freeform.  

 

Trong bài này bạn chỉ học cách sử dụng Pen. Path có thể được đóng hoặc mở. Một Path mở là nó có 

hai điểm bắt đầu và kết thúc không trùng nhau. Path đóng là điểm bắt đầu và kết thúc gặp nhau tại một 

điểm. Ví dụ vòng tròn là Path đóng. Những loại Path mà bạn vẽ tác động đến nó sẽ được chọn và điều 

chỉnh như thế nào. 

Những Path mà chưa được tô hoặc Stroke sẽ không được in ra khi bạn in hình ảnh của mình. Bởi vì 

Path là dạng đối tượng Vector và nó không chứa những Px, nó không giống như những hình bitmap 

được vẽ bởi Pencil và những công cụ vẽ khác. Trước khi bắt đầu, bạn nên tìm hiểu những tuỳ biến của 

công cụ Pen và môi trường làm việc của bạn để chuẩn bị cho bài học này. 
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1. Trong hộp công cụ chọn công cụ Pen ( ) 

2. Trên thanh tuỳ biến công cụ, chọn hoặc thiết lập những thông số sau: 

 

A. Paths option B. Geometry Options menu C. Add to Path Area option 

3. Nhấp vào Path Palette để mở rộng palette đó ra ngoài nhóm layer palette. Path palette hiển thị hình 

xem trước của path mà bạn vẽ. Hiện tại Palette đang không có gì bởi vì bạn chưa bắt đầu. 

Vẽ một đường thẳng 

Đường thẳng được tạo ra bằng cách nhấp chuột. Lần đầu tiên bạn nhấp chuột, bạn sẽ đặt điểm bắt 

đầu cho Path. Mỗi lần nhấp chuột tiếp theo, một đường thẳng sẽ xuất hiện giữa điểm trước đó và điểm 

vừa nhấp chuột. 

1. Sử dụng công cụ Pen, đặt con trỏ vào điểm A trong template và nhấp chuột. Sau đó nhấp vào điểm 

B để tạo một đường thẳng. Khi bạn vẽ path, một vùng lưu trữ tạm thời có tên là Work Path xuất hiện 

trong Path Palette để đi theo từng nét vẽ của bạn. 

 

2. Kết thúc Path bằng cách nhấp vào công cụ Pen ( ) trong hộp công cụ. Những điểm nối Path lại với 

nhau gọi là Anchor Point. Bạn có thể kéo những điểm riêng lẻ để sửa chữa từng phần của Path, hoặc 

bạn có thể chọn tất cả những điểm Anchor để chọn cả path. 
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3. Trong Path Palette, nhấp đúp vào Work Path để mở hộp thoại Save Path. Đặt tên cho nó là Straight 

Lines và nhấn OK để đặt tên cho Path. Path vẫn được chọn trong path palette. 

 

Bạn nên tạo cho mình thói quen lưu lại Work Path nếu bạn sử dụng nhiều path khác nhau trên cùng 

một tài liệu. Nếu bạn bỏ chọn một Work Path đã có trong Path Palette và tiếp tục một path mới, một 

Work Path mới sẽ thay thế cái cũ, và tất nhiên là cái cũ sẽ bị mất. Tuy nhiên nếu bạn bỏ chọn Work 

Path trong Path Palette, thì Work Path và những gì bạn đang vẽ vẫn ở đó trong khi bạn làm những việc 

khác mà không phải là vẽ Path. Bạn cũng có thể chọn lại Work Path và tiếp tục thêm vào những gì 

đang vẽ. 

Đôi điều cần biết về Anchor Point, đường định hướng, điểm định hướng và những thành tố 
khác: 

Path bao gồm một hoặc nhiều đường thẳng và cong. Anchor Point đánh dấu những điểm kết thúc của 

Path. Ở vùng path cong, mỗi một điểm Anchor point được chọn hỉên thịn một hoặc hai đường định 

hướng, kết thúc ở điểm định hướng. Vị trí của đường định hướng và Point xác định kích thước và hình 

dạng của những vùng Path cong. Di chuyển những thành phần này sẽ định dạng lại những đường cong 

của Path. Một path có thể là path đóng mà không có cả điểm đầu và kết thúc ví dụ như hình tròn, hoặc 

là Path mở với điểm đầu và điểm kết thúc không trùng nhau ví dụ là đường gợn sóng. 

Một đường cong mềm mại được nối với nhau bởi những điểm Anchor Point và gọi là những Smooth 

Point. Những đường cong sắc nhọn được nối với nhau bởi những Corner Point. Khi bạn di chuyển 

đường định hướng trên một Smooth Point, vùng cong ở hai bên của điểm đó tự đồng điều chỉnh đồng 

thời. Ngược lại, khi bạn di chuyển đường định hướng trên một Corner Point, chỉ duy nhất vùng con ở 

trên cùng một bên của điểm tại đúng vị trí đường định hướng được điều chỉnh.  

Một path không nhất thiết phải là một loạt những phần nhỏ nối tiếp với nhau. Nó có thể bao gồm nhiều 

hơn một những thành phần Path riêng lẻ. Mỗi hình dạng trong Shape Layer là một thành phần của 

path, được miêu tả là Clipping Path của layer. 
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Di chuyển và điều chỉnh Path 

Bạn sử dụng công cụ Direct Selection để chọn và điều chỉnh những điểm neo (anchor point) ở trên một 

phần của path hoặc cả path. 

1. Chọn công cụ Direction Select ( ) được ẩn dưới công cụ Path Select ( ) trong hộp công cụ.  

Để chọn công cụ Direct Selection bằng lệnh gõ tắt nhấn phím A. Hơn nữa, khi công cụ Pen đang 

được chọn bạn có thể tạm thời chuyển qua công cụ Direct Selection bằng cách giữ phím Ctrl. 

2. Nhấp vào điểm A-B để chọn nó trong cửa sổ, và sau đó di chuyển Path bằng cách kéo nó đi loăng 

quăng với công cụ Direction Selection. 

 

3. Để điều chỉnh độ dốc hoặc chiều dài của Path, kéo một điểm neo với công cụ Direct Selection. 

 

4. Chọn công cụ Pen ( ) 

5. để tiếp tục với Path kế tiếp, giữ con trỏ qua điểm C để cho một chữ x xuất hiện trên con trỏ của công 

cụ Pen chỉ ra rằng nếu bạn nhấp chuột sẽ bắt đầu một path mới, và sau đó nhấp vào điểm C. 
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6. Nhấp vào điểm D để vẽ Path giưa hai điểm. 

 

7. Đóng Path lại sử dụng những phương pháp sau: 

- Nhấp vào công cụ Pen trong hộp công cụ 

- Giữ phím Ctrl để tam thời chuyển sang công cụ Direct Selection và nhấp ra ngoài Path. 

Vẽ một đường thẳng với nhiều phần khác nhau 

Cho đến lúc này bạn đã thực hành với path có 2 điểm. Bạn có thể vẽ một đường thẳng phức tạp hơn 

bằng công cụ Pen chỉ đơn giản bằng cách thêm điểm vào. Những đoạn và những điểm neo này có thể 

được loại bỏ sau này, bạn có thể loại từng em một hoặc chơi một phát cả lũ hy sinh. 

1. Sử dụng công cụ Pen ( ) nhấp vào điểm E để bắt đầu một path tiếp theo. Sau đó giữ phím Shift và 

nhấp vào điểm F, G, H và I. Giữ phím shift sẽ giúp bạn tạo một đường xiên một góc 45 độ. 

 

Chú ý: Nếu bạn vẽ sai gì đó, chọn Edit > Undo để thử lại hoặc bạn có thể dùng History Palette. 

2. Để đóng path lại sử dụng những phương phá bạn đã học. Khi một path chưa nhiều hơn một phân 

đoạn, bạn có thể kéo từng điểm neo riêng lẻ để điều chỉnh những phân đoạn riêng lẻ của path. Bạn 

cũng có thể chọn tất cả những điểm neo trên Path để chỉnh sửa cùng một lúc. 
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3. Chọn Direct Selection ( ) 

4. Nhấp vào phân đoạn zic zac và kéo để di chuyển toàn bộ các phân đoạn khác. Khi bạn kéo, cả hai 

điểm neo của phân đoạn đó đều di chuyển theo và những phân đoạn nói với nhau cũng tự điều chỉnh 

theo. Độ dài và độ dốc của những phân đoạn đựơc lựa chọn và vị trí của những điểm neo khác không 

thay đổi. 

5. Chọn một trong những điểm neo đơn lẻ tren Path và kéo nó tới một vị trí mới. Chú ý tới những thay 

đổi của nó tới một phân đoạn gần kề hoăc những phân đoạn khác. 

6. Alt-click để chọn cả đoạn path. Khi cả đoạn path được chọn, tất cả những điểm neo thành màu đen. 

 

    Kéo từng điểm riêng lẻ           Alt-click để chọn toàn bộ path 

7. Kéo path để di chuyển toàn bộ path mà không làm ảnh hưởng đến hình dạng của nó 

Tạo một Path đóng 

Tạo một path đóng khác biệt với tạo một path mở ở cách mà bạn đóng path. 

1. Chọn công cụ Pen ( ) 

2. Nhấn vào điểm J để bắt đầu Path, sau đó nhấp vào điểm K và điểm L 

3. Để đóng lại path, đặt con trỏ qua điểm khởi đầu là điểm J, một vòng tròn nhỏ xuất hiện với công cụ 

Pen chỉ ra rằng Path đó sẽ đóng lại nếu bạn nhấp chuột. Đóng một Path sẽ tự động kết thúc path. Sau 

khi path đó bị đóng, con trỏ của công cụ pen sẽ lại xuất hiện một dấu x, chỉ ra rằng nếu bạn nhấp chuột 

sẽ tạo ra một path mới. 
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4. Để thực hành thêm, bạn vẽ thêm một path đóng nữa, sử dụng hình ngôi sao có sẵn 

5. Khám phá những thumbnail trong Path Palette. Tại điểm này, tất cả những path bạn vẽ xuất hiện 

trong Work Path Straight Lines ở trong Path Palette. Mỗi một path riêng lẻ trong path Straight Line 

được gọi là subpath (Path phụ) 

Tô vẽ với path 
Path và những điểm neo không phải là những thành phần sẽ được in ra của hình ảnh. Bởi vỉ những 

điểm màu đen bạn nhìn thấy trên màn hình khi bạn vẽ với công cụ Pen là path chứ không phải là nét 

vẽ nó không đại diện cho bất cứ một đơn vị Pixel của hình ảnh nào. Khi bạn bỏ chọn Path, những điểm 

neo và path sẽ bị ẩn đi. Bạn có thể làm cho path xuất hiện khi in ấn bằng cách thêm nét vẽ cho nó, 

bằng cách này bạn sẽ thêm những đơn vị pixel vào hình ảnh. Stroke sẽ tô màu dọc theo Path, Fill sẽ tô 

vùng bên trong của một path đóng bằng cách tô nó với một màu, hình ảnh hoặc Pattern. Để stroke 

hoặc fill path bạn phải chọn nó trước. 

1. Đổi màu nên trước thành màu đen 

2. Chọn công cụ Direct Selection ( ) và nhấp để chọn đường thẳng zic zac trong cửa sổ 

3. Trên menu của Path Palette, chọn Stroke Subpath để mở hộp thoại Stroke Subpath 
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4. Ở ô Tool, chọn Brush từ menu hiển lên và nhấp OK. Path của bạn đã được stroke với những thông 

số của brush hiện tại 

 

Chú ý: Bạn có thể chọn một công cụ vẽ và thiết lập thông số trước khi bạn chọn Tool trong hộp thoại 

Stroke Subpath. 

Bây giờ bạn sẽ tô cho một trong những path đã tạo 

5. Nhấp vào hình tam giác với công cụ Direct Selection. Sau đó chọn Fill Subpath từ menu Path 

Palette. Hộp thoại Fill Subpath xuất hiện 

6. Trong hộp thoại này, nhấp Ok để chấp nhận mặc định. Hình tam giác được tô với màu của nền 

trước. 

 

7. Để ẩn path, nhấp vào một vùng trống dưới tên của Path ở trên Path Palette 
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8. Chọn File > Close và không  cần lưu lại gì hết. 

Vẽ một path cong 
Path cong được tạo bởi nhấp và kéo. Lần đâu tiên bạn nhấp và kéo, bạn sẽ đặt điểm bắt đầu cho path 

cong và cũng xác định luôn hướng của đường cong. Khi bạn tiếp tục kéo, path cong sẽ được vẽ ở giữa 

điểm trước đó và điểm hiện tại. Khi bạn kéo công cụ Pen, Photoshop vẽ một đường định hướng và 

điểm định hướng từ những điểm neo. Bạn có thể sử dụng những đường định hướng và điểm định 

hướng để điều chỉnh hình dạng và hướng của đường cong. Bạn sẽ chỉnh sửa path bằng cách sử dụng 

đường định hướng và điểm định hướng sau khi bạn thực hành với path cong. 

 

Giống như path chưa được tô, đường định hướng và điểm định hướng không được in ra sau này bởi 

vì chúng là đối tượng vector mà không chứa các đơn vị Px. 

1. Sử dụng File Browser hoặc chọn File > Open để mở file Curve.psd trong thư mục Lesson9. 

2. Chọn công cụ Pen ( ) 

3. Kéo con trỏ của công cụ Pen, bắt đầu từ điểm A và dừng lại tại điểm đỏ trên đường định hướng. Khi 

bạn thả chuột, một điểm neo sẽ xuất hiện tại điểm A và hai đường định hướng sẽ mở rộng lên trên và 

xuống dưới điểm neo. 
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4. Kéo từ điểm B đến điểm đỏ nằm dưới nó 

Chú ý: Nếu bạn có sai sót gì trong khi vẽ, chọn Edit > Undo để làm lại hoặc dùng History Palette. Nếu 

bạn giữ phím Shift bạn sẽ có được một đường định hướng nghiêng một góc là 45 độ 

 

5. Để hoàn thành đường cong bằng cách kéo từ điểm C đến điểm đỏ của nó và từ điểm D đến điểm đỏ 

của nó. Kết thúc path sử dụng một trong những phương pháp đã học. Bây giờ bạn hãy tạm thời lưu lại 

Work Path để tránh bị mất nội dung của nó. 

6. Nhấp đúp vào Work Path trong Path Palette để mở hộp thoại Save Path. Trong ô name điền Curve 1 

và nhấn OK. 

Tạo những Work Path độc lập 
Khi bạn vẽ những phân đoạn thẳng ở đầu bài học này, bạn đã vẽ một đường thẳng đứng, một đường 

nghiêng, một đường zic zac, và một hình tam giác. Tất cả những đường này là Subpath của Work Path 

Straight Lines trong Path Palette. Đôi lúc bạn muốn phân chia những line khác nhau khi bạn vẽ với một 

path hoàn thiện, do đó bạn có thể chỉ định những tính năng thêm vào mức độ của Path. Để bắt đầu 

một Work Path mới, bỏ chọn path hiện tại trên path Palette và bắt đầu vẽ. 

1. Trong Path Palette, nhấp chuột chọn một vùng trống dưới Curve 1 để bỏ chọn Path. 
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Chú ý: Khi bạn bỏ chọn một path trogn Path Palette, tất cả path hoặc subpath trong nó đều bị bỏ chọn. 

Nó sẽ ẩn đi bởi vì path không mang các đơn vị pixel trong nó. 

2. Kéo lên từ điểm E cho đên điểm màu đỏ, Khi bạn thả chuột từ điểm E một đường Work Path mới sẽ 

xuất hiện trên Path Palette. 

3. Kéo từ điểm F lên điểm đó. 

 

4. Kết thúc path bằng những cách đã học. 

5. Nhấp đúp vào Work Path trong Path Palette để mở hộp thoại Save Path, chõ Curve 2 để đặt tên cho 

nó và nhấp OK 

6. Trong Path Palettee, nhấp vào một vùng trống dưới Curve 2 để bỏ chọn nó. 

 

Vẽ một path cong đóng 

Bây giờ bạn sẽ vẽ một đường tròn, sử dụng những phương pháp học được từ việc vẽ đường cong. 

1. Kéo từ điểm G lên đến điểm màu đỏ, sau đó kéo xuống từ điểm H đến điểm màu đỏ. 

2. Đóng Path lại bằng cách đặt con trỏ qua điểm G và nhấp chuột. 
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3. Trên Path Palette, nhấp đúp vào Work Path và gõ chữ Closed path để đặt tên cho nó, sau đó nhấp 

vào một khoảng trống để bỏ chọn 

Sửa chữa Path cong 

Bây giờ bạn sẽ sửa chững đường cong mà bạn vừa vẽ 

1. Chọn Direct Selection ( ).  

Để chọn công cụ Direct Selection bằng lệnh gõ tắt nhấn phím A. Hơn nữa, khi công cụ Pen đang 

được chọn bạn có thể tạm thời chuyển qua công cụ Direct Selection bằng cách giữ phím Ctrl. 

2. Trong Path Palette, nhấp vào Curve 2 để chọn nó, sau đó nhấp vào path trên cửa sổ chính để chọn 

nó 

3. Nhấp vào điểm E và kéo một trong những điểm định hướng của nó theo hướng nào tuỳ bạn để thay 

đổi độ dài, độ dốc hoặc cả hai hướng cho đường định hướng đó. 

Chú ý rắng độ dốc của những đường định hướng khác của điểm đó cũng thay đổi cho nên nó luôn luôn 

là một đường 180 độ từ điểm mà bạn đang kéo.  

 

4. Bây giờ kéo điểm neo E để thay đổi vị trí của đường cong 
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5. Thử kéo phân đoạn đó và chú ý những gì xảy ra cho đường định hướng và các điểm neo. 

Stroke và Fill path 

Ở phần trên của bài học này, bạn đã sử dụng lệnh Stroke ở Path Palette để thêm màu cho đường 

path. Bạn có thể Stroke hoặc Fill path bằng cách kéo tên của path vào một nút đặc biệt ở dưới cùng 

của Path Palette. Để thiết lập những tuỳ chọn mà bạn sẽ áp dụng cho path, bạn sẽ chọn một công cụ 

vẽ và những tuỳ biến của nó trước khi bạn kéo path vào nút đặc biệt này trên Path Palette. 

Chú ý: Những nút trong Path Palette áp dụng những nét vẽ trên toàn bộ subpath liên quan đến nó trên 

cùng một path. Để áp dụng nét vẽ chỉ cho vài subpath, sử dụng lẹnh Stroke thay thế. 

1. Chọn công cụ Brush ( ) 

2. Kéo path Curve 1 vào nút Stroke Path With Brush ( ) ở dưới cùng của Path Palette để stroke path 

với thông số của brush. Chú ý rằng tác vụ này không chọn Curve 1 Path, Curve 2 path vẫn được chọn 

trên path Palette. 

 

Nếu bạn muốn thêm lệnh Fill hoặc Stroke vào Path đã được lựa chọn trong Path Palette, bạn 

không cần phải kéo nó vào nút kia trong Path Palette bạn chỉ cần nhấp vào nút đó nếu bạn muốn áp 

dụng.  
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3. Trong Path Palette, kéo Closed path vào nút Fill Path With Foreground Color ( ) ở dưới cùng của 

Path Palette để tô nó với màu nền trước. Khi bạn tô một path mở, Photoshop sẽ tự động vẽ một đường 

thẳng không nhìn thấy được nối điểm điểm đầu và điểm cuối, và tô cho những khoanh vùng nằm giữa 

nó 

4. Đặt màu nền trước là màu khác, bạn tuỳ chọn. 

5. Trong Path Palette, kéo Curve 1 vào nút Fill Path With Foreground Color. 

6. Chọn File > Close và không cần lưu lại. 

Kết hợp những phân vùng path cong và thẳng 

Bạn đã học được cách vẽ đường cong và đường thẳng riêng biệt, bây giờ bạn sẽ kết hợp nó lại để tạo 

ra những góc tròn và những đường cong mềm mại. Những điểm neo Smooth có những đường định 

hướng hoàn toàn khác biệt nhau. Conner point thì không có nhiều đường định hướng mà chỉ có một 

hoặc hai có độ lơn của góc là 180 độ.  

Kết hợp hai phần vùng cong tại một góc nhọn 

Một trong những sự kết hợp khó khăn nhất là kết hợp hai path cong nhập vào nhau ở một góc. Bạn sẽ 

thực hành với nó ngay bây giờ để biết tôi nói là không sai.  

1. Sử dụng File Browser hoặc chọn File > Open để mở file Combo.psd trong thư mục Lesson9. 

2. Chọn công cụ Pen 

3. Kéo từ điểm A lên điểm màu đỏ, và sau đó kéo từ điểm B xuống điểm màu đỏ ở dưới nó. Tại điểm 

B, bạn phải tạo một điểm Conner để thay đổi hướng của đường cong tiếp theo. 

4. Alt-click vào điểm B để thiết lập Conner Point. Chú ý rằng con trỏ bao gồm một mũi tên nhỏ khi bạn 

giữ phím Alt xuống. 
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5. Giữ phím Alt xuống lần nữa, kéo từ điểm B đến điểm màu đỏ, để thêm vào đường định hướng. 

Đường mới sẽ tác động tới hướng của đường cong mà bạn sẽ vẽ tiếp theo, khi bạn thêm một điểm 

neo khác. 

 

6. Kéo xuống từ điểm C từ điểm màu đỏ để hoàn thiện path. Sau đó kết thúc path bằng cách bạn đã 

học. 

Kết hợp phần vùng cong với đường thẳng 

Khi bạn tạo một path mà kết hợp đường thẳng và đường cong, bạn tạo một conner point để chỉ ra điểm 

chuyển đổi từ đường thẳng thành đường cong và ngược lại. Ở phần này bạn sẽ vẽ hai phân đoạn 

đường thẳng riêng biệt, tạo hai hình cong riêng biệt: một hình bán nguyện và một hình chữ S. Vị trí của 

đường định hướng cho conner point xác định loại đường cong nào sẽ được tạo. 

1. Để bắt đầu vẽ Path thứ 2 (đầu tiên là đường thẳng), nhấp vào điểm D với công cụ Pen, và giữ phím 

Shift và click vào điểm E (đừng kéo). 

2. Di chuyển con trỏ qua điểm E và kéo đến điểm màu đỏ để thiết lập đường định hướng cho phân 

đoạn sau sẽ là một đường bán nguyệt hướng lên trên 

 

3. Kéo từ điểm F đến điểm màu đỏ và giữ Alt-click vào điểm F để tạo Conner point 
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4. Giữ phím Shift và nhấp vào điểm G để tạo một đường thẳng. Sau đó kết thúc path lại 

5. Nhấp vào điểm H bằng công cụ Pen để bắt đầu một path mới cho đường cong chữ S và giữ phím 

Shift và click vào điểm I 

6. Tại điểm I, Alt-kéo từ điểm I đến điểm màu đỏ để tạo cho điểm I một conner point. 

 

7. Kéo điểm J xuống điểm màu đỏ. 

 

8. Alt-click vào điểm J để biến nó thành conner point. 
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9. Shift-click vào điểm K và sau đó đóng path lại với những cách bạn đã học 

10. Chọn File > Close 

Chỉnh sửa những điểm neo 
Một trong những điểm thuận lợi khi vẽ bằng công cụ Pen là bạn có thể quay lại và thay đổi đưòng path 

bạn vẽ. Bạn đã học cách di chuyển điểm neo, phân đoạn, và các đường định hướng. Trong phần này, 

bạn sẽ thấy việc thêm một điểm neo vào một path có sẵn đễ dàng như thế nào, xoá điểm neo, và biến 

đổi những điểm neo từ một dạng này sang dạng khác. 

Thêm và bớt điểm neo 

Bạn có thể thêm điểm neo vào một path để gia tăng số phân vùng của path đó và bạn có thể bớt 

những điểm neo không cần thiết trên path. 

1. Sử dụng File Browser hoặc chọn File > Open để mở file Edit.psd trong thư mục Lesson9. Hai path 

đã được đặt tên và lưu lại trong path Palette. Bạn sẽ chỉnh sửa path bằng cách sử dụng công cụ Pen 

và công cụ Convert Point. 

2. Trong Path Palette, nhấp vào path ở trên (có tên là Add and delete points) để chọn nó. Hai subpath 

sẽ xuất hiện trong cửa sổ chính. 

3. Chọn cộng cụ Add-anchor point ( ) được nằm ẩn dưới công cụ Pen. Sau đó định vị con trỏ qua 

điểm đỏ ở trung tâm của đường thẳng và nhấp chuột. Một điểm neo với đường định huớng sẽ được 

thêm vào phân vùng, và con trỏ xuất hiện là một mũi tên rỗng ( ) do đó bạn có thể chọn và sửa đổi 

path. 

4. Bây giờ chọn và kéo path quay lên trên. Tiếp đến bạn sẽ bỏ đi những điểm neo trên path. 
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5. Chọn công cụ Direct Selection ( ) và chọn Path thứ 2 

Chú ý: Bạn phải chọn path trước khi bạn có thể xoá điển neo của nó. Tuy nhiên bạn có thể chọn pth và 

điểm neo mà không cần phải chọn công cụ. Nếu path được chọn, chỉ việc di chuyển công cụ Pen qua 

một phân đoạn để thay đổi nó thành công cụ add-anchor-point 

6. Chọn công cụ delete-anchor-point ( ) ẩn đưới công cụ Add-anchor-point ( ), đặt con trỏ trên chấm 

đỏ qua tâm của điểm neo, và nhấp vào nó để xoá điểm neo. 

 

Biến đổi điểm neo 

Đôi khi bạn có thể muốn thay đổi đường cong thành một conner point và ngược lại. Sử dụng công cụ 

Convert Point sẽ dễ dàng giúp bạn được điều này. Sử dụng công cụ Convert Point gần giống như vẽ 

bằng công cụ Pen. Để biến một đường cong thành một conner point, bạn nhấp chuột vào điểm neo đó, 

và để biến một conner point thành đường cong, bạn kéo từ điểm neo đó. 

1. Trong Path Palette, chọn Convert Direction path. Hình dạng path có bốn conner points và các đường 

cong. Bạn sẽ bắt đầu với việc biến những conner poin thành đường cong, và sau đó bạn sẽ biến 

đường cong thành conner point. 

2. Sử dụng công cụ Direct Selection ( ), chọn vùng ngoài của subpath 

3. Chọn công cụ Convert Point ( ) được ẩn dưới công cụ delete-anchor-point tool ( ) 

4. Đặt con trỏ lên một điểm của path bên ngoài, và nhấp và kéo theo chiều kim đồng hồ để biến điểm 

neo từ conner point thành đường cong. 
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5. Biến những điểm còn lại thành Smooth point để hoàn thành đường bên ngoài. 

 

6. Sử dụng công cụ Convert Point ( ), nhấp vào vùng tỏng của subpath để chọn nó và sau đó nhấp 

vào điểm neo ở trên đỉnh của mỗi đường cong để biến nó thành điểm uốn. Bạn cũng có thể sử dụng 

công cụ Convert Point để điều chỉnh một bên của một phân vùng cong. Bạn sẽ thử cách này ở vùng 

ngoài của path 
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7. Nhấp vào vùng ngoài của path với công cụ Direct Selection ( ), sau đó nhấp vào một phân vùng 

cong sao cho đường định hướng và điểm định hướng xuất phát từ một điểm neo. 

 

8. Chọn lại công cụ Convert Point ( ), kéo một trong những điểm định hướng để thay đổi hình dạng 

của một cạnh của đường cong. 
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9. Đóng tài liệu lại mà không cần lưu gì hết. 

Sử dụng Path với hình ảnh 

Bạn đã thực tập một số với những hình có sẵn, bạn sẽ sử dụng công cụ Pen để tạo vùng lựa chọn cho 

chiếc đĩa bay sau. Chiếc đĩa bay có đường viền rất dài, cong và mềm mại. Nó sẽ rất khó nếu bạn dùng 

phương pháp khác để tạo vùng lựa chọn. Bạn sẽ vẽ một đường Path xunh quanh tấm hình và tạo hai 

đường khác ở trong tấm hình. Sau khi bạn vẽ xong đường Path, bạn sẽ biến chúng thành vùng lựa 

chọn. Tiếp theo bạn sẽ bớt vùng lựa chọn của hình này từ hình khác sao cho mỗi chiếc đĩa bay được 

chọn và không có chút nào của hình bầu trời hết. Cuối cùng bạn sẽ tạo một layer mới từ bức hình chiếc 

đĩa bay và thay đổi hình hình nền của nó.  

Khi bạn vẽ với những đường path tự do sử dụng công cụ Pen, sử dụng càng ít điểm neo càng tốt để 

tạo ra hình mà bạn muốn. Càng ít điểm neo được dùng, đường cong càng mêm mại và công việc của 

bạn càng hiệu quả. Điều cốt lõi trong bài học này là bạn sẽ sử dụng công cụ Pen để nối những chấm 

từ điểm A đến điểm N và quay lại điểm A, hãy thực hành với những gì bạn học ở chương này để tạo ra 

những loại điểm neo khác nhau. 
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       Cách làm đúng                   Có quá nhiều điểm neo 

• Bạn sẽ thành lập những phân đoạn thẳng chỉ đơn giản bằng cách nhấp chuột tại điểm C, F, J 

và M 
• Bạn sẽ tạo đường uốn mềm bằng cách kéo điểm màu đỏ cho các điểm A, D, E, G, H, I, K và J 

Bạn sẽ đặt một điểm uốn cho quá trình chuyển đổi từ đường cong thành một phân đoạn thẳng (tại 

điểm B) bằng cách trước tiên tạo một điểm Smooth Curve - lần nữa, bằng cách kéo điểm màu đỏ - và 

sau đó loại bỏ một trong những đường định hướng bằng cách nhấn Alt-Click 

• Bạn sẽ thiết lập một điểm uốn cho quá trình chuyển đổi từ phân đoạn thẳng thành một đường 

cong bằng cách đầu tiên nhấn nhưng không kéo để tạo ra một điểm uốn và sau đó giữ phím 

Alt và kéo điểm neo N. 
• Nếu bạn đã sẵn sàng để thực hành, bạn có thể tập làm bài này sử dụng những lời chỉ dẫn ở 

trên. Hoặc theo những bước sau trước để đảm bảo bạn đi đúng hướng. 

Vẽ path theo hình bằng Pentool 
Sử dụng những bước sau để tạo đương Path, đường phác thảo của hình chiếc tầu vũ trụ 

1. Sử dụng File Browser hoặc chọn File > Open để mở file Saucer.psd trong thư mục Lesson9 

2. Chọn công cụ Pen. 

3. Đặt con trỏ ở điểm A và kéo đến điểm màu đỏ để thiết lập một điểm neo và định hướng cho đường 

cong đầu tiên. Sau đó làm tương tự với điểm B. Tại góc của buồng lái (điểm B), bạn sẽ cần phải tạo 

một điểm uốn, để tạo một vùng chuyển giao giữa phân vùng cong và thẳng.  
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4. Alt-click điểm B để chuyển Smooth Point thành điểm uốn bằng cách loại bỏ một trong những đường 

định hướng. 

 

              Thiết lập Smooth point tại B          Biến đổi Smooth point thành điểm uốn 

5. Nhấn vào điểm C để lập một phân vùng thẳng (đừng kéo) 

6. Kéo lên điểm D từ điểm màu đỏ. Sau đó kéo xuống từ điểm E đến điểm màu đỏ của nó 

7. Nhấp vào điểm F 

8. Thiết lập điểm uốn ở G, H và I bằng cách kéo từng cái một đến những điểm màu đỏ tương ứng. 

9. Nhấp vào điểm J 

10. Thiết lập điểm uốn tại K và L bằng cách kéo từng cái một đến những điểm màu đỏ tương ứng. 

11. Nhấp vào điểm M và sau đó là N 

12. Giữ phím Alt và kéo từ điểm N đến điểm màu đỏ, để thêm một đường định hướng vào điểm neo tại 

N 

13. Di chuyển con trỏ qua điểm A sao cho một vòng tròn nhỏ xuất hiện ở con trỏ, và nhấp để đóng 

đường Path lại. (vòng tròn nhỏ có thể khó nhìn vì hình này tối màu cho nên nó lẫn vào nền). 
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14. Trong Path Palette, nhấp đúp vào Work Path, gõ chữ Saucer vào hộp đặt tên và sau đó nhấn OK 

để lưu nó lại. 

15. Đóng tìa liệu lại nếu bạn muốn lưu thì chọn Save. 

Biến một vùng lựa chọn thành Path 

Bạn sẽ tạo một đường Path thứ hai nhưng sử dụng phương pháp khác. Trước tiên bạn sẽ dùng công 

cụ lựa chọn để chọn những vùng màu tương đồng, sau đó bạn sẽ biến vùng lựa chọn thành đường 

Path. Bạn có thể biến bất cứ vùng lựa chọn nào được tạo bởi bất kỳ công cụ lựa chọn nào thành 

đường Path. 

1. Nhấp chuột chọn thẻ Layer Palette để hiện thị nó, sau đó kéo layer Template xuống biểu tượng 

thùng rác ở dưới cùng của layer palette. Bạn không cần đến nó nữa hay nói cách khác là nó hết giá trị 

lợi dụng! ka ka ka! 

 

2. Chọn công cụ Magic Wand ( ) 

3. Ở thanh tuỳ biến công cụ của Magic Wand, điền vào giá trị là 32 

4. Hãy cẩn thận nhấp vào vùng màu đen bên trong cánh thăng bằng của đĩa bay. 

5. Shift-Click ở trong cánh thăng bằng còn lại để tạo vùng lựa chọn cho vùng màu đen đó. 
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6. Nhấp vào thẻ Path Palette để hiển thị nó. Sau đó nhấp vào nút Make Work Path From Selection (

). Vùng lựa chọn sẽ được chuyển thành Path, và một Work Path mới được tạo. 

 

Chú ý: Nếu cần bạn có thể điều chỉnh những điểm neo của đường Path, sử dụng công vụ và cách thức 

đã học. 

7. Nhấp đúp vào Work Path và đặt tên nó là Fins, nhấn OK để lưu lại 

 

8. Nếu cần thì lưu file lại. 
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Biến đổi đường Path thành vùng lựa chọn 

Cũng như khi bạn biến một vùng lựa chọn thành Path, bạn có thể biến đường Path thành vùng lựa 

chọn. Với những nét rất mềm mại, đường Path cho phép bạn tạo ra những vùng lựa chọn chính xác. 

Vừa rồi bạn đã vẽ đường Path cho con tầu vũ trụ và hai cánh cân bằng của nó, bay giờ bạn sẽ biến 

đường Path này thành vùng lựa chọn và áp dụng hiệu ứng Filter lên vùng lựa chọn này. 

1. Trong Path Palette, nhấp vào Saucer Path để chọn nó. 

2. Biến Saucer path thành vùng lựa chọn bằng những sau: 

• Ở Path Palette, chọn Make Selection và nhấn Ok để đóng hộp thoại vừa xuất hiện. 
• Kéo Saucer Path vào nút Load Path As Selection ( ) 

Sau đó bạn sẽ bớt vùng lựa chọn của cánh thăng bằng của vùng lựa chọn tàu vũ trụ để bạn có thể 

xem hình nền thay đổi thông qua vùng trong suốt của cánh thăng bằng. 

3. Trong Path Palette, nhấp chuột chọn Fins path, và trong Path Palette menu chọn Make Selection. 

 

4. Ở phần Operation của hộp thoại Make Selection, chọn Subtract from Selection và nhấn Ok 

Đường Fins path sẽ biến thành vùng lựa chọn và đồng thời bớt đí từ vùng lựa chọn của tàu vũ trụ. Cứ 

để đường path được chọn bởi vì bạn sẽ sử dụng vùng lựa chọn cho bước kế tiếp: 

Thêm layer để hoàn thành bài tâp 

Bước này chỉ chỉ cho bạn thấy dùng công cụ Pen để tạo vùng lựa chọn sẽ giúp bạn đặt được những 

hiệu ứng hấp dẫn cho hình ảnh như thế nào. Bởi vị bạn đã tách được con thuỳên, bạn sẽ tạo một bản 

copy của vùng lựa chọn trên một layer mới. Sau đó, khi bạn thêm một đối tượng vào layer nằm giữa 

layer gốc và layer copy, đối tượng đó sẽ xuất hiện ở giữa đĩa bay và nền trời sao. 

1. Trên Layer Palette, chọn layer Background do đó bạn có thể nhìn thấy vùng lựa chọn ở cửa sổ 

chính. Nếu bạn bỏ chọn nó, bạn phải lặp lại bước trước để chọn. 
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2. Chọn Layer > New > Layer Via Copy 

Một layer mới xuất hiện ở Layer Palette có tên là Layer 1. Ở hình nhỏ trên layer palette bạn chỉ thấy 

hình chiếc tàu vũ trụ mà không có bầu trơi sao vì bạn đã tách nó và dùng vùng lựa chọn để tạo layer 

mới. 

3. Trong layer palette, nhấp đúp vào layer 1 và gõ chữ Saucer để đặt tên lại cho nó 

 

4. Lưu file dưới về máy và mở nó ra trong Photoshop 
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5. Trong hộp công cụ chọn công cụ Move và kéo hình hành tinh sang cửa sổ Saucer.psd. 

 

6. Đóng file hành tinh lại và chỉ để lại file tàu vũ trụ. Hành tinh sẽ xuất hiện đằng trước hình đĩa bay. 

Bây giờ bạn phải chuyển hình chiếc đĩa bay xuất hiện lên trên hành tinh. 

7. Trong Layer Palette, kéo hình hành tinh nắm giữa layer đĩa bay và layer background. 

8. Vẫn sử dụng công cụ Move, kéo hình hành tin để thay đổi vị trí cua nó cho đến khi bạn hài lòng với 

vị trí mới. 

10. Chọn File > Save ... 

Bạn đã hoàn thành bài học với công cụ Pen. Bạn hãy thực hành thêm bằng cách vẽ đường path xung 

quanh đối tượng bằng công cụ Pen. Khi bạn đã sử dụng công cụ Pen thành thạo, bạn sẽ thấy rằng 

Pen rất tốt khi dùng để tách những hình phức tạp. 
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Câu hỏi ôn tập 

1. Bạn làm thế nào để chỉnh sửa những phân vùng đơn lẻ của đường Path? 

2. Bạn làm thế nào để chọn được toàn bộ đường Path? 

3. Bạn thêm điểm neo như thế nào? 

4. Bạn làm cách gì để xoa những điểm neo trên đường Path 

5. Khi bạn kéo vối công cụ Pen để tạo đường cong, đường cong sẽ bị tác động như thế nào bởi hướng 

mà bạn kéo? 

Đáp án: 

1. Để sửa chữa từng phân vùng đơn lẻ của đường Path, bạn kéo những điểm neo trên đường Path sử 

dụng công cụ Direct Selection. Bạn cũng có thể chỉnh sửa hình dạng của phân vùng cong đó bằng 

cách kéo điểm định hướng tại điểm cuối của đường định hướng mà được mở rọng ra ở điểm neo của 

đường cong.  

2. Để chọn toàn bộ đường Path, giữ phím Alt và nhấp vào đường Path sử dụng công cụ Direct 

Selection. Khi toàn bộ đường path được chọn, tất cả những điểm neo thành màu đen 

3. Để thêm điểm neo vào đường Path, bạn chọn côgn cụ add-anchor-point được ẩn dưới công cụ Pen 

và sau đó thì nhấp vào đường Path nơi mà bạn muốn thêm điểm neo. 

4. Để xoa điểm neo từ đường Path, bạn chọn công cụ delete-anchor-point được ẩn dưới công cụ Pen 

và sau đó nhấp vào điểm neo mà bạn muốn loại bỏ. 

5. Hướng mà bạn kéo với công cụ Pen xác định hướng của đường cong mà nó sẽ theo. 

6. Nếu bạn muốn tạo một vùng lựa chọn phức tạp, thì sử dụng công cụ Pen để vẽ sẽ dễ dàng hơn và 

sau đó dùng lệnh chuyển Path thành vùng lựa chọn. 
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c¸c c«ng cô trong Photoshop 
I>c¸c hç trî cho vïng chän 
1> 
-mét vïng chän ®· cã(chän tr−íc mét vïng chän)+d÷ Shift -> céng thªm vïng 
chän 
+Alt->trõ bít vïng chän 
+Alt+Shift->giao 
+Ctrl+D-> huû 
+Ctrl+shift+D->LÊy l¹i vïng chän 
-To¹ vïng chän víi h×nh khèi míi 
D÷ Shift ®Ó t¹o ra h×nh vu«ng,h×nh trßn 
D÷ Alt ®Ó lÊy to¶ theo t©m 
+thuéc tÝnh Eather t¹o khoang mê cho vïng chän 
+thuéc tÝnh Unti-alised khö c¸c chÕ ®é c¾t r¨ng c−a 
2> 
-ThiÕt lËp vïng chän theo chÕ ®é tù do 
+polygond lasso.. Ên delete xo¸ lïi 
+manatip lasso lÊy theo vïng gi¸p lai gi÷a hai vïng mµu kh¸c nhau 
3> 
-Magic Wand tool -> lÊy mÉu theo vïng mµu ngÉu nhiªn 
+Tolerance:®Æt gi¸ trÞ dung sai cña vung chän ngÉu nhiªn 
4>Crop tool :c¾t ¶nh 
+opacity:®é mê ®ôc cña vïng ®−îc c¾t 
+color:chän mµu 
5> 
Slice tool :chuyÓn khung c¾t ¶nh lªn m¹ng 
+bá chÕ ®é Slice vµo View/show extras 
6> 
Airbrush:nhãm c«ng cô phun mµu 
+Prossure:c«ng suÊt phun mµu  
+Mode:chän kiÓu hoa chén khi t« 
Chó ý:khi sö dông c¸c c«ng cô ®Ò cã cì bót nh¸y ph¶i chuét chän Edit....(enter) 
+Spacing:b−íc bót 
-Hardness:®é cøng cña bót 
7> 
Nhãm c«ng cô t« vÏ 
Paitbrush tool 
+Wet edges:lµm næi c¹nh 
+mode: chän chÕ ®é 
-Pencil tool 
8> c«ng cô lÊy mÉu mµu 
-Clone stamp tool:T« ®¾p mµu theo c¸c vïng t−¬ng øng 
+D÷ phÝm Alt lÊy mÉu mµu,bá Alt ®Ó t« 
-Oppacity:tû suÊt khi lÊy mÉu mµu 
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-Pattern stamp:lÊy mÉu theo vïng chän cho tr−íc 
+T¹o vïng chän h×nh ch÷ nhËt kh«ng cã thuéc tÝnh feather=0 
-chän menu Edit/define patterm 
+®Æt tªn cho mµu t«/Ok 
+bá vïng chän ®· cã 
quay trë l¹i pattern stamp/chän patterm(chän mÉu mµu cÇn t« mÉu võ a t¹o) 
9>Nhãm c«ng cô tÈy c¸c hiÖu øng ®· lµm 
-History Brush:bá c¸c hiÖu øng ®· lµm trong vïng chän hoÆc líp 
-Alt history brush:t¹o ra nÐt cä vÏ nghÖ thuËt 
+Opacity:®é ®Ëm nh¹t 
+style:kiÓu 
+fidelitg:ph¹m vi lan to¶ 
+Area:diÖn tÝch 
+spacing :b−íc nh¶y 
10> Nhãm c«ng cô tÈy. 
- eraser tool: tÈy tù nhiªn 
-background eraser: tÈy nÒn 
- magic eraser: xo¸ ngÉu nhiªn 
11>T¹o gi¶i mÇu 
-gradient tool: t¹o gi¶i mÇu 
-paint bucket tool:®æ mÇu 
12>Nhãm c«ng cô lµm nhoÌ ,s¾c nÐt 
-blur tool: lµm nhoÌ t¨ng ®é mÞn 
-shafen tool: lµm s¾c nÐt 
-pressure: t¨ng hiÖu qu¶ c«ng suÊt 
-smudge tool: di nhoÌ 
13> Nhãm c«ng cô däi s¸ng, tèi 
-dodge:  däi s¸ng 
-burn:     lµm tèi 
-sponge tool : lµm l¹nh  
14> Nhãm c«ng cô xª dÞch ®−êng hiÖu chØnh 
-path component selection: di chuyÓn ®−êng  
-direct selection: ®iÓu chØnh c¸c ®iÓm chèt 
(khi sö dông c«ng cô direct nh¸y ph¶i chuét vµo ®iÓm neo cã c¸c chÕ ®é hç trî) 
-delete anchor point – xo¸ ®iÓm neo 
-delete path – xo¸ ®−êng 
-make selection - ®−a ®−êng thµnh vïng chän 
-fiil path – t« ®Çy ®−êng 
- stroke path- t« c¹nh 
- free tranfer point- biÕn ®æi tù do mét ®iÓm 
- (tr−íc khi dïng c«ng cô nµy th× ph¶i dïng c«ng cô t¹o ®−êng tr−íc) 
15>Nhãm c«ng cô t¹o ®−êng  
-pen tool: vÏ tù do 
- freeform pen: biÕn d¹ng ®−êng tù do 
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- pen tool:vÏ tù do 
- -free form pen:BiÕn d¹ng ®−êng tù do 
- add anther point:thªm ®iÓm 
- Convert :®¶o ®iÓm 
1.6Nhãm c«ng to¹ ch÷(T) 
- -B«i  ®en ch÷ sö dông warptext (creat warptext)[T] ®Ó biÕn ®æi ch÷ (t¹o vïng 

chän b»ng ch÷,create a mask on selecttion) 
1.7 nhãm c«ng cô t¹o vÏ h×nh tù do(c¸c h×nh vÏ tù do cã thÓ ®−îc hiÓu lµ c¸c 
®−êng path .. ®−îc t« ®Çy,hiÖu chØnh c¸c ®iÓm nh− trong c«ng cô (path 
component....))(14) 
1.8 ThiÕt lËp c¸c vÞ trÝ chó ý 
-notes tool:b¸o c¸c ®iÓm chó ý  theo vÞ trÝ tù do 
-audio annotation tool:thiÕt lËp chÕ ®é ©m thanh 
1.9Nhãm c«ng cô lÊy mÉu mµu 
-eye droper tool:lÊy mÉu theo ®iÓm nh×n cña m¾t(®iÓm ®¬n) 
-color sampler tool:®o kho¶ng c¸ch 
20.c«ng cô xª dÞch ®iÓm nh×n(hand tool) 
dïng phÝm c¸ch ®Ó di chuyÓn khi vïng muèn chän bÞ khuÊt 
21.c«ng cô room:Ctrl+”+” ®Ó t¨ng vïng nh×n 
Ctrl+”-”®Ó thu nhá vïng nh×n 
(chó ý thay ®æi kÝch th−íc cña bót vÏ dïng hai phÝm “[ “vµ ”]”) 
gâ phÝm f c¸c thay ®æi c¸c chÕ ®é hiÓn thÞ mµn h×nh 
c¸c hç chî cho vung chän 
-víi vïng chän ®· cã nh¸y chuét ph¶i vïng ®· chän 
+deselect:bá vïng chän 
+feather :®Æt gi¸ trÞ mê cña c¹nh c¾t 
+save selecttion:ghi l¹i vïng ®· cã-Name 
*lÊy l¹i vïng chän ®· ghi: 
-ë menu select/load selecttion/chän vïng cÇn chän ®Ó hiÖu chØnh 
+make work path:®−a thµnh ®−êng hiÖu chØnh 
cao cÊp (dïng c«ng cô Delecttion tool) 
+sau khi hiÖu chØnh song nh¸y chuét ph¶i vµo vïng chän sau ®ã cã c¸c t×nh huèng 
sau: 
+delete path:xo¸ ®−êng hiÖu chØnh 
+Make selecttion:®−a l¹i vïng chän 
+fill path:®æ mµu 
+stroke path:T« c¹nh 
+clipping path: ®−a vµo vïng nhí ¶o 
+free tranform path:biÕn ®æi tù do c¸c ®iÓm hiÓn thÞ,khi biÕn ®æi 
-layer via copy :nh©n ®«i ®èi t−îng trong vïng chän thµnh mét líp míi 
+layer via cut:c¾t ®èi t−îng ®−a vµo vïng míi 
+new layer:chuyÓn vïng chän ch−a cã ®èi t−îng hiÖu chØnh 
+free tranform:biÕn ®æi tù do c¸c ®èi t−îng trong vïng chän 
+tranform selecttion:chØ biÕn ®æi vïng chän 
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+fill:t« ®Çy 
+stoke:t« c¹nh 
-Blending: 
+mode:chän kiÓu 
+opacty:§é mê ®ôc 
+location: 
*c¸ch t¹o khung cho vung chän 
1.thay ®æi vïng lµm viÖc 
-Canvas size 
+current size:kÝch th−íc míi 
-Chän tÊt(menu select) 
menu select\all 
II.Layer 
duplicate:copy líp míi ®Õn vÞ trÝ míi 
-AS :tªn líp 
-dÐtination:®iÒu khiÓn vÞ trÝ míi cña líp 
layer properties:t¹o thuéc tÝnh cho líp 
-Name:tªn layer 
-color:chän mµu cho líp 
+layer style:kiÓu cho líp 
-blending option: 
+drop shadow:t¹o bãng ®æ 
-blend mode:chän chÕ ®é hoµ chén mµu bãng ®æ 
opacity:®é mê ®ôc cña bãng ®æ 
-angle:gãc chiÕu s¸ng cu¶t bãng ®æ 
-use global light:sö dông ¸nh s¸ng mÆc ®Þnh 
-distance:kho¶ng c¸ch cña bãng ®æ 
-spead:cÊp ®é s¸ng tèi cña bãng ®æ 
-size:kÝch cì cña bãng ®æ 
-quality:thiÕt lËp c¸c hiÖu øng cho bãng ®æ 
-contour:chän vÞ trÝ cho bãng ®æ 
-®iÒu khiÓn theo ma trËn (kÝch ®óp vµo vïng contour) 
-noise:®ä nhiÔu  
+inner shadow:to¹ bãng ®æ phÝa trong 
-choke:®é nhoÌ 
+outer glow:vïng s¸ng bªn ngoµi  
-elements:thiÕt lËp tõng thµnh phÇn cho quÇng s¸ng 
-spead:t¨ng ®é mµu cho quÇng s¸ng 
-size:cì quÇng s¸ng 
inner glow:vïng s¸ng phÝa trong(t−¬ng tù nh− outer) 
+bevel and emboss:v¸t siªn vµ ch¹m næi 
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Nhóm Công Cụ Retouch Healing Brush(CS4) 

 

Kích vào nút bung trên công cụ Healing Brush sẽ xuất hiện nhóm công cụ 
như sau: 
 

 

I – Công cụ Healing Brush :  
Healing Brush cũng là một công cụ nhân bản,cho phép chúng ta chỉnh sửa 
những vùng chưa hoàn thiện của một file ảnh, làm cho chúng hòa lẫn vào 
vùng ảnh xung quanh một cách liền lạc, tự nhiên. Cũng giống như công cụ 
Clone Stamp (Bấm Alt + Click chuột trên vùng ảnh để lấy mẫu tô,xong click 
vào vùng ảnh cần clone),Healing brush sẽ sử dụng mẫu tô hay pattern tùy 
theo sampled  hay pattern  đang được 
chọn trên thanh tùy chọn. 
 
Để “giữ nguyên mẫu tô” sau khi clone,bạn chọn replace trong tùy 
chọn Mode. Các tùy chọn khác cũng tương tự như công cụ Clone Stamp, 
nếu không nhớ các bạn có thể xem lại. 
 

II – Công cụ Spot Healing Brush:  
Công cụ Spot Healing Brush sẽ xóa bỏ những vết dơ hay những vùng 
chưa hoàn hảo trên ảnh của bạn một cách nhanh chóng.Công cụ Spot 
Healing Brush làm việc cũng tương tự như Healing Brush,tuy nhiên nó 
không yêu cầu bạn phải lấy mẫu mà sẽ tự động lấy mẫu tô, nên không có 
việc bấm Alt để lấy mẫu pixel như Healing Brush.Tôi ít khi sử dụng công cụ 
này vì không thích automatic quá nhiều. 
 

III – Công cụ Patch :  
Patch cũng là một công cụ nhân bản (clone) nhưng cách làm việc của công 
cụ này hơi khác các công cụ trên.Bạn có thể sử dụng công cụ này như một 
công cụ tạo vùng chọn. 
 

1- Chọn biểu tượng  trên thanh công cụ. 
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2- Chọn source trên thanh tùy chọn.  
3- Rê chuột vẽ vùng chọn quanh “vùng ảnh xấu” 
4- Đưa trỏ chuột vào bên trong vùng chọn, giữ chuột và rê sang “vùng ảnh 
tốt”. Khi nhả chuột “vùng ảnh tốt” sẽ lấp vào “vùng ảnh xấu”. 

 
Nếu trên thanh tùy chọn bạn chọn Destination, khi vẽ vùng chọn và rê vùng 
chọn sang nơi khác thì phần ảnh bên trong vùng chọn sẽ được nhân bản 
sang vị trí mới. 
 

 
Khi các bạn vừa tạo xong vùng chọn, nút use pattern  trên thanh 

tùy chọn sẽ có hiệu lực.Bấm vào nút pattern  để chọn một 
pattern,xong bấm vào nút use pattern để clone bằng pattern. 

 

 

IV- Công cụ Red eye :  
Công cụ này dùng để khử mắt đỏ một cách nhanh chóng. 
 

-Chọn biểu tượng  trên thanh công cụ. 
-Click chuột vào ngay vùng màu đỏ trên mắt,màu đỏ sẽ bị khử đi trả lại 
tròng mắt bình thường.Nếu chưa hài lòng với kết quả vừa thực hiện, bạn 
bấm Ctr-Z để hủy lệnh đó,xong thay đổi giá trị Pupil size hoặc Darken 
amount và thực hiện lại lệnh.Bạn cứ thoải mái làm lại đến khi nào cảm thấy 
vừa ý thôi,cho dù bạn chỉnh sửa suốt ba ngày ba đêm thì tôi vẫn không 
một chút phàn nàn.  
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Tạo Vùng Chọn Bằng công cụ Magic Wand và Quick 
Selection 

  

1-Công cụ Magic Wand (đũa thần):  
 
Chọn biểu tượng trên thanh công cụ,xong kích vào một vùng trên file ảnh 
thì một vùng chọn sẽ xuất hiện. 

 

 
 
-Ý nghĩa các nút trên thanh tùy chọn:  
 

Các nút New;Add,Subtract, intersec,Refine Edge 
của phần lớn các công cụ chọn đều giống nhau tôi đã giải thích trong 
những phần trước nên không nhắc lại ở đây, nếu không nhớ các bạn có 
thể xem lại tại đây.  
 
Tùy chọn Tolerance : Quyết định „những màu tương tự” với màu mà bạn 
chọn.Bạn nhập vào một giá trị tính bằng pixel,trong giới hạn từ 0 đến 
255.Giá trị nhỏ thì số pixel chọn sẽ ít,giá trị lớn thì số pixel chọn sẽ 
nhiều,photoshop sẽ tính toán để tìm chọn những pixel “gần giống” với pixel 
ngay vị trí bạn kích chuột căn cứ vào dung sai mà bạn cho trong hôp số 
tolerance.Nếu giá trị là 255 thì toàn bộ hình ảnh sẽ được chọn, ngược lại 
giá trị là 0 thì chỉ chọn những pixel “giống hệt” pixel ngay vị trí bạn kích 
chuột. 
 
Tùy chọn Anti-alias : Bạn kiểm nhận vào nút này để tạo độ mượt đường 
biên vùng chọn. Tùy chọn Contiguous : Nếu kiểm nhận tùy chọn này thì 
những pixel tương tự nằm gần kề với vị trí kích chuột mới được chọn, nếu 
không thì chọn trên phạm vi toàn hình. 
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Tùy chọn Sample all layer : Nếu được kiểm nhận thì phạm vi tính toán 
được áp dụng trên toàn bộ layer nhìn thấy được, nếu không thì chỉ tính 
toán dựa trên layer hiện hành (layer mà bạn đang làm việc). 
 

2-Công cụ Quick Selection :  
 
Chọn biểu tượng trên thanh công cụ, chọn 1 trong 3 tùy chọn New, Add to 
Subtract from trên thanh tùy chọn, xong click giữ chuột và rê trên file ảnh ở 
nơi muốn tạo vùng chọn,vùng chọn sẽ tự động tạo ra khi rê chuột. 
 

 

 
 
Thanh tùy chọn như sau: 

 
- Các bạn có thể thay đổi “nét cọ” lớn nhỏ tùy ý thông qua hộp chọn Brush 
trên thanh tùy chọn.Tìm hiểu thêm về nét cọ bấm vào đây. 
 
-nút New là giá trị mặc định ban đầu khi chưa có vùng chọn nào được tạo, 
Khi tạo xong vùng chọn thì nút new sẽ tự động chuyển sang Add to.  
+ Muốn cộng thêm vùng chọn : Chọn Add to  
+Muốn trừ vùng chọn : Chọn Subtract from 
 

http://piconline-fourkeys.blogspot.com/2009/04/tim-hieu-them-ve-net-co.html
http://3.bp.blogspot.com/_8tM_FVaOl98/Sg0b-gfdRGI/AAAAAAAABjs/0uXspZk7P70/s1600-h/quick.gif
http://3.bp.blogspot.com/_8tM_FVaOl98/Sg0abN43ebI/AAAAAAAABjM/ITlQcyXLasg/s1600-h/hinh-3.gif
http://3.bp.blogspot.com/_8tM_FVaOl98/Sg0bf7AAGnI/AAAAAAAABjc/hWBVAAgFdjw/s1600-h/option-2.gif
http://3.bp.blogspot.com/_8tM_FVaOl98/Sg0b-gfdRGI/AAAAAAAABjs/0uXspZk7P70/s1600-h/quick.gif
http://3.bp.blogspot.com/_8tM_FVaOl98/Sg0abN43ebI/AAAAAAAABjM/ITlQcyXLasg/s1600-h/hinh-3.gif
http://3.bp.blogspot.com/_8tM_FVaOl98/Sg0bf7AAGnI/AAAAAAAABjc/hWBVAAgFdjw/s1600-h/option-2.gif
http://3.bp.blogspot.com/_8tM_FVaOl98/Sg0b-gfdRGI/AAAAAAAABjs/0uXspZk7P70/s1600-h/quick.gif
http://3.bp.blogspot.com/_8tM_FVaOl98/Sg0abN43ebI/AAAAAAAABjM/ITlQcyXLasg/s1600-h/hinh-3.gif
http://3.bp.blogspot.com/_8tM_FVaOl98/Sg0bf7AAGnI/AAAAAAAABjc/hWBVAAgFdjw/s1600-h/option-2.gif


Photoshop CS 

 

Trungnghia_dt@yahoo.com Page 1 
 

Nhóm công cụ tạo vùng chọn mở rộng 

 

Ở bài trước các bạn đã hiểu rõ công dụng của các công cụ tạo vùng chọn 
trong nhóm công cụ marquee (gồm có Rectangular, Elliptical,Single row và 
Single column).Trong bài này tôi sẽ giới thiệu thêm một số tùy chọn liên 
quan đến nhóm công cụ trên.Các bạn xem hình sau: (nhớ là kích vào hình 
để xem full size vì hình minh họa chỉ xuất hiện dạng thumbnails). 
 

 

Các bạn chú ý trên thanh tùy chọn (tôi tô màu xanh nhạt) và các 
số 1,2,3,4 tôi đánh dấu trên hình. 
 
Khi các bạn kích hoạt công cụ Rectangular Marquee (hay Elliptical 
marquee) thì trên thanh tình trạng nút số 1 sẽ mặc nhiên được chọn, nút 
này là “new selection” có nghĩa là khi bạn tạo một vùng chọn,rồi tiếp tục tạo 
thêm một vùng nữa (hoặc 2, 3,…. vùng nữa)thì vùng chọn cũ bị mất đi chỉ 
còn duy nhất một vùng chọn mà bạn tạo sau cùng.Cũng đúng thôi vì bản 
thân nó là new selection nên chỉ giữ lại một vùng chọn mới nhất mà thôi. 
 
Kế bên là nút số 2, nút này là “add to selection” nghĩa là cộng vùng 
chon.Bạn chọn công cụ Reactangular hay Elliptical,xong bạn kích hoạt nút 
số 2 trên thanh tùy chọn rồi tiến hành tạo vùng chọn trên file ảnh.Tạo vùng 
đầu tiên rồi đến vùng thứ 2 (có thể 3, 4 hoặc nhiều vùng tùy bạn),khi đó kết 
quả là vùng tổng hợp của các vùng trên.  
 
Nút số 3 là “subtract from selection” nghĩa là trừ vùng chọn.Cũng tương tự 
như cộng nhưng kết quả là trừ vì vùng chọn đầu tiên bị vùng thứ hai “thẻo 
mất” một phần.  
 
Cuối cùng là nút số 4 “intersec with selection” có nghĩa là giao giữa các 
vùng chọn,kết quả là phần giao nhau giữa hai vùng chọn. Nếu các bạn 
không thích chọn các nút 1,2,3,4 trên thanh tùy chọn thì có thể dùng 
phím.Bạn tạo vùng chọn đầu tiên sau đó bấm phím shift rồi tạo vùng chọn 
thứ hai để có kết quả là cộng vùng chọn;bấm Alt để có kết quả là trừ và 
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bấm Alt+Shift để có kết quả là giao. Hình minh họa đơn giản bên dưới giúp 
các bạn dễ hình dung. 
 

 

Bên cạnh các nút 1,2,3,4 là tùy chọn Feather, giá trị mặc định của hộp số 
này là 0, muốn hiểu rõ hơn dùng Feather để làm gì các bạn hãy bấm vào 
đây. 
 
Tiếp theo là tùy chọn style: 
 
-Mặc định của style là normal, nghĩa là bạn được phép tạo vùng chọn một 
cách thoải mái,lớn nhỏ tùy thích, bạn rê chuột đến đâu sẽ tạo vùng chọn 
đến đó.Khi chọn normal thì ô nhập thông số Width;Height kế bên sẽ không 
có hiệu lực. 
 
-Nếu chọn style là Fixed aspect ratio thì khung Width và Height sẽ có hiệu 
lực, bạn nhập giá trị vào hai ô này,khi đó vùng chọn bạn tạo ra sẽ có tỷ lệ 
chiều rộng và cao như bạn chọn.Ví dụ bạn nhập thông số chiều rộng 
(width) là 1 và chiều cao (hieght) là 3 thì vùng chọn dù lớn hay nhỏ vẫn giữ 
đúng tỷ lệ rộng/cao là 1/3. 
 
-Nếu chọn style là Fixed size (kích thước cố định) thì vùng chọn bạn tạo ra 
sẽ có kích thước cố định theo thông số bạn nhập vào ô width (độ rộng) và 
Height (độ cao).Ví dụ bạn muốn tạo vùng chọn ngang 10cm và cao 15cm 
thì bạn nhập vào ô width 10cm và ô height 15cm.Khi đó trên file ảnh bạn 
chỉ cần kích chuột là sẽ có một vùng chọn đúng bằng kích thước trên. 
Cuối cùng là nút Refine Edge,kích vào nút này (sau khi đã tạo vùng chọn) 
sẽ xuất hiện cửa sổ như sau: 
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-Radius : xác định kích thước khu vực xung quanh biên vùng chọn, gia 
tăng thông số này sẽ tạo vùng chọn chính xác hơn và phạm vi "hòa trộn 
pixels" cũng lớn hơn. 
 
- Contras : làm sắc nét lại đường biên vùng chọn. 
 
-Smooth : Giảm sự "lòi lõm" góc cạnh của đường biên vùng chọn tạo sự 
mềm mại cho đường biên. 
 
-Feather : Tạo sự chuyển tiếp mềm mại giữa những pixels bên trong và 
ngoài vùng chọn,giá trị feather từ 0 đến 250px. 
 
-Contract/Expand : Thu nhỏ hoặc mở rộng đường biên vùng chọn,giá trị từ 
0-100% là mở rộng và từ 0 đến -100% là thu nhỏ.Việc thu nhỏ đường biên 
giúp loại bỏ thêm những pixels ngoài vùng chọn so với vùng chọn ban đầu. 
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   THIẾT KẾ NÉT CỌ CHO CÔNG CỤ 
BRUSH  

 
 
1.)Mở 1 file ảnh muốn làm brushes  

                                                           

2.)Chuyển nó về chế độ đen trắng (Ở đây có ai chưa biết cách chuyển không nhỉ 
- tui nói nhiều lắm rồi ) 
3.)Vào Edit > Define Brush ... Lưu lại với cái tên tuỳ ý  

 



4.) Kết quả bạn sẽ có 1 Brushes như ý hiện trong bảng Brushe 

 

- Rất tiện lợi cho bạn sau này , khi cần , bạn chỉ cần nhấn B để chọn công cụ 
Brush sau đó chọn loại Brush mà bạn vừa làm , sau đó kích vào vị trí mà bạn 
muốn đặt , bạn sẽ thấy rất OK 

 

Forum 

 

http://www.ps.4csvn.biz/2


Xóa nền với công cụ Photoshop 
Bước 1: Khởi động Photoshop CS5, mở hình cần xóa nền. 

 



 
Bước 2: Chọn công cụ Quick Selection (W), tạo vùng chọn với công cụ Quick 
Selection. 

 
Bước 3: Sau đó nhấn chọn nút Refine Edge… 



 
Khi hộp thoại Refine Edge xuất hiện, bạn nhấn chọn nút xổ xuống ở ô View để chọn 
chế độ nền tạm thời theo vài kiểu mặc định của Photoshop CS5. 

 
Ví dụ trong trường hợp này, bạn chọn On White (W) thì vùng hình ảnh bị xóa tạm 
thời được thay thế với màu trắng. Mục đích là để xem trước kết quả việc xóa nền, 
nhất là phần biên hình bị xóa. 



 
Bước 4: Nhấn chọn Smart Radius và kéo tăng giá trị px của Radius ở mục Edge 
Detection, để lấy lại được các sợi tóc rìa hoàn hảo hơn. 



 
 



Bước 5: Chọn công cụ Erase Refinements (E), tô lên các vùng cần phục hồi lại các 
vùng biên hình đã bị xóa. 



 
Bước 6: Nếu ưng ý, bạn chọn Output To là New Layer và nhấn OK. 



 
Kết quả việc xóa nền 



 
Cuối cùng, bạn chọn hình nền để ghép vào ảnh chân dung. 



 
 


